LT5C Label Printer

User's Guide

v 1.0

 Manual Configuration
The following manuals are included with the product.
 Residual Risk
This manual describes the map of residual risks that require protective measures by users.
 Setup Guide
This manual describes how to connect the printer to a computer and set it up following installation.
 User’s Guide (This Manual)
This manual describes details about product functions and operations.
 Maintenance Guide
This manual describes how to replace consumables, and how to clean and maintain the product.

The latest versions of the manuals and installer can be downloaded at the Afinia
Label website.
https://afinialabel.com/LT5Cinfo
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 Reading the Manual
Symbols
Note
 These are cautions and restrictions for the correct operation of the device. Make sure to read to avoid misoperation.

Memo
 These are references and information that are useful when using the device. We recommend reading them.

Reference
 These are the reference pages. Read to learn detailed information and relevant information.

WARNING
Mishandling due to ignoring this display may cause death or serious injury.

CAUTION
Mishandling due to ignoring this display may cause personal injury.

Keys, Buttons, and Symbols
This chapter describes the following keys, buttons, and symbols.
Inscription

Description
 Indicates hardware buttons and the numeric keypad on the control
panel.
E.g.:

< > button/key

<OK> button
<Fn> key

<BACK> button
<CLEAR> key

 Indicates your PC keyboard.
[]

 Indicates menu names on the display screen.
 Indicates menu, window, and dialog names on the computer.

""

 Indicates messages and input text on the display screen.
 Indicates file names and screen names on the computer.
 Indicates reference titles.

>

Indicates how to get to the item you want in the menu of this printer or
the computer.
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Illustrations
Unless otherwise specified, the printer illustrations used herein show the printer with the unwinder
mounted.
Illustrations may differ from the actual product.

Screens
The images of the control panel and PC used herein are examples. The images may differ from actual
products and screens.

Inscriptions
The following inscriptions are used in this manual.
®

®

®

®

 Microsoft Windows 10 64-bit Edition operating system → Windows 10 (64-bit version)
 Microsoft Windows 10 operating system → Windows 10
Unless otherwise specified, the examples in the manuals included with the printer show operation using
Windows 10 and the LT5C printer.
Depending on the OS, model, and version you are using, descriptions in this manual may differ from
what you actually encounter.
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Printing on Various Papers

Printing on Various Papers
Usable Media Types
For high-quality printing it is necessary to use paper that satisfies conditions regarding quality,
thickness, paper finish, etc. If printing on paper not recommended by Afinia Label, thoroughly test
the print quality and paper traveling performance, etc., and check that there are no impediments
before use.
If using a (paper) medium that is curled or wrinkled before printing, print quality and paper
traveling performance cannot be assured.

Paper Types, Size, and Thickness
 Roll Paper Specifications
Reference
 Refer to the “Maintenance Guide” for specific paper sizes.
Roll Paper Types
Media Form

Description

Continuous Paper

Paper wound on a roll

Continuous Paper (Black Mark)

Paper wound in a roll with black marks printed on the back surface

Die-cut Label (Gap)

Paper that is die-cut into a label shape

Die-cut Label (Black Mark)

Paper that is die-cut into a label shape with black marks printed on the back
surface

Continuous Label

Paper that is not die-cut into a label shape, with the entire surface covered with
label paper

Continuous Label (Black Mark)

Paper that is not die-cut into a label shape, with the entire surface covered with
label paper and black marks printed on the back surface

Media Type

Description

Plain

Wood-free Paper

Plain Labels

Label paper made of wood-free paper

Glossy Labels

Label paper made of glossy paper

Film Labels

Label media made of film

Film

Film

Roll Paper Size
Roll Outside Diameter

No greater than 203.2 mm (8 inches)

Paper Width

25.4 to 130 mm (1 to 5.12 inches)

Paper Thickness

0.07 mm to 0.25 mm (0.003 to 0.0098 inches)

Roll Core Width

Same as roll paper

Roll Core Inner Diameter

76.2 mm

Note

*

`

* When there is backing paper, total thickness includes backing paper.

 Using metal foil paper or conductive paper creates the risk of defective printing due to electrical discharge, and device
malfunction.
 Use paper that has black marks printed on its back surface (non-printing surface). Black marks printed on the front surface
cannot be detected.
 Use paper with black marks printed with carbon ink. Use paper with black marks that have a reflective index of less than 10%.
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Printing on Various Papers
 Die-cut labels that are used in Gap Mode must satisfy the following conditions.
The transparency of the label part (including both the label and the label liner) must be below 25%.
The liners must be within a range of 10% to 45% transparent. However, the transparency of the liners must be more than 1.8
times the transparency of the label part.
 Die-cut labels that are used in Gap Mode cannot use transparent liners or labels.
 Die-cut labels that are used in Black Mark Mode cannot use transparent liners.
 Use continuous labels that have been smoothed on both edges and have been dry edge processed. Recommended
specifications are for paper that has 2 mm of liner on both edges. Please refer to the “Maintenance Guide” for details.
 Thermal paper will become discolored and deformed by heat used for fusing. Do not use it.
 Use film that can withstand heat up to 230°C. Use of film that is not heat resistant creates the risk of film deformation by heat
used for fusing, paper jams, and device malfunction.
 Do not use a liner on which glue is smeared. It will not feed correctly in the equipment. In the worst case, it could damage the
equipment.
 Cast-coated paper is not recommended. Printing quality cannot be guaranteed when it is used.
 If the paper length, label length, or black Mark Interval for a single sheet is less than 4 inches, blank sheets may be printed to
satisfy the paper length that can be fed.
 When printing on paper that is cut to less than 152 mm (6 inches) long in the direction that media is fed, it may feed at an
angle.
If this happens, print it so there is a continuous length that is longer than 152 mm (6 inches).
 When printing on paper that is very narrow (25.4 mm (1 inch)), it may feed at an angle at about 80 mm from the cut trailing
edge.
 When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), smeared or smudged printing may occur near
the cut trailing edge as the roll diameter gets smaller.
 When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), slight damage may occur at the leading edge
as the roll diameter gets smaller.
 Use of the types of paper below is not supported.
Paper whose roll surfaces are not cut cleanly.
Paper that is connected part way through by tape, etc.
Label paper without backing paper with paste on the front surface
Paper whose labels are easy to peel or are peeling
Paper with paste squeezing out onto the base paper area or affixed to the label surface
Paper that is folded or bent
Paper that has holes in it
Paper that is notched
Paper that has perforations
Paper with different size labels on a single roll
Paper with different paper widths on a single roll
Media that has liners and labels that are both transparent (cannot be used even if it has black marks)
Continuous paper that is transparent (cannot be used even if it has black marks)

 Setting the Paper Weight
Set the printer and printer driver paper weight according to the weight of the paper to be used.
Paper Weight
(Total thickness including
backing paper)

Setting Value of the
Media Weight

76 to 95 μm

Light

96 to 140 μm

Medium Light

141 to 159 μm

Medium

160 to 180 μm

Medium Heavy

181 to 199 μm

Heavy

200 to 214 μm

Ultra Heavy1

215 to 229 μm

Ultra Heavy2

230 to 249 μm

Ultra Heavy3

- 13 -

Printing on Various Papers

Storing Media
Improper paper storage can cause absorption of
moisture, discoloration, and warping. Note that
printing on such paper can adversely affect print
quality, feeding, etc. Leave packages of media
unopened until you are actually ready to use
them.

 Store media in locations like the
ones described below
 On a flat shelf in a location that is dark and
where there is little moisture
 On a flat table
 An environment with a temperature of 23°C
±1°C and humidity of 50%RH ±2%

 Avoid locations like the ones
described below
 Directly on the floor
 In direct sunlight
 Near the inside surface of an external wall
 On a surface that is uneven or curved
 In a location where electrostatic charge is
generated
 In a location subjected to very high
temperatures or sudden temperature changes
 Next to a photocopying machine, air
conditioning equipment, heater, or duct
Note
 Proper printing may not be possible on paper that has
been stored for a long time.
 Leaving roll paper in an environment where it is exposed
to high temperatures and high humidity for long periods
can cause it to become deformed. Do not use deformed
roll paper. Store roll paper in an environment where the
temperature and humidity are appropriate.
 We recommend putting partially used label paper back
into the vinyl bag it was packaged in, to prevent the paper
from absorbing moisture.
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Registering a Desired Paper Size with the Printer Driver

 Registering a Desired Paper Size with the Printer
Driver

1
2

Click [Start] and select [Control Panel]
in [Windows System].

(5)

Select a Media Weight to match the
paper thickness.
Memo

Click [View devices and printers].

 If you are unsure of the paper thickness,
select [Medium Light].

(6)

Enter paper size information.

(2)
(1)

(3)
(4)
(5)
(6)

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].
Memo

On the [Setup] tab, click [User-defined
paper].

 Input the label length and gap for media that has
gaps and the black mark interval for black mark
media.
 Use a ruler to measure, as accurately as possible,
the actual size of the media, and then input those
values.
 If the label length or the black mark interval is less
than 4 inches, use the following method to measure
the media, and then input values to the first decimal
place to be accurate.
1

2

3

4

5

6

7

8

9

10

11

(3)L/10-Gap length(mm)
(2)L/10(mm)
(1)L(mm)

How to Measure the Actual Size of Paper

5

(1) Measure the length from the leading edge of the
first label (or black mark leading edge) to the
leading edge of the 11th label (or black mark
leading edge). Use this as L (mm).

Input information about the paper you
want to register.

(2) Divide the length you measured in (1) by 10 to
calculate the length from the leading edge of the
first label (or black mark leading edge) to the
leading edge of the 2nd label (or black mark leading
edge) to the first decimal place.

(1)

Use [Registered user-defined
paper] to select "New Paper".

(2)

In the [Paper Name] box, enter a
paper name.

(3) Subtract the length of the gap from the length you
calculated in (2) to calculate the length of one label
to the first decimal place.

(3)

Select a Media Form to match the
paper.

For media that has gaps, input the value calculated in (3)
in [Label length] and input the gap length in [Gap].

(4)

For media that has black marks, input the value
calculated in (2) in [Black Mark Interval].

Select a Media Type to match the
paper.
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Using the Printer Driver
to Fine-tune the Print
Position

Memo
 A blank piece of paper may be inserted after cut
pages if the paper length, label length, or black
mark interval is less than 4 inches.

6

Enter other information as required.

(1)

If you performed sensor
adjustment, select the sensor
setting that was registered to the
device from [Sensor settings].

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Click [View devices and printers].

Memo
 Refer to “Calibrating the Sensor” (P.30)
regarding how to adjust the sensor.

(2)

If you want to fine-tune the
image position, enter the position
shift amount into [Print position
correction].

(3)

If you want to fine-tune the paper
cut position, enter the position
shift amount into [Cut position
correction].

(1)

(2)
(3)

7

When all the input is complete, click
[Add].
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On the [Setup] tab, click [User-defined
paper].

Registering a Desired Paper Size with the Printer Driver

5

Use the [Registered user-defined paper]
list to select the paper whose print
position you want to correct.
Memo

9
10

 If the paper you want to use is not in the list, select
[New paper] and add it. See “Registering a Desired
Paper Size with the Printer Driver” (P.15).

6

In [Print position correction], set the
values for the print start positions
vertically and horizontally on the paper.

7

Click [Overwrite].

8

Click [OK] or [Close] as many times
as necessary to exit the "Printing
preferences" screen.
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Open the file to be printed.
Specify the paper size, and then print.

Registering a Desired Paper Size with the Printer Driver

Using the Printer Driver to
Fine-tune the Cut Position

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

5

Use the [Registered user-defined paper]
list to select the paper whose cut
position you want to correct.
Memo
 If the paper you want to use is not in the list, select
[New paper] and add it. See “Registering a Desired
Paper Size with the Printer Driver” (P.15).

Click [View devices and printers].

6

Use [Cut position correction] to specify
an adjustment value for distance from
the print completion position to the cut
position.

7

Click [Overwrite].

On the [Setup] tab, click [User-defined
paper].
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Registering a Desired Paper Size with the Printer Driver

8

Click [OK] or [Close] as many times
as necessary to exit the “Printing
preferences” screen.

9
10

Open the file to be printed.
Specify the paper size, and then print.
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Note
 The examples in this chapter use Windows WordPad for explanations. Depending on the
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Preparing Paper

Preparing Paper
This section describes how to load paper onto the holder of the unwinder.
For paper sizes and types that can be loaded onto the unwinder, see “Roll Paper Specifications” (P.12).

1
2

Remove the paper from the packaging.
Take care of the tape that is holding the
leading edge of the paper.

3

Check the leading edge of the paper
and cut it off straight.
If the leading edge of the paper is cut
straight, you can just load it as is.

If there is no tape holding the leading
edge of the paper, you can just load it
as is.

Be particularly careful when replacing
paper and after removing and reloading
jammed paper.

(1)

(1)

Remove the tape that is holding
the leading edge.
Note

Note

 Remove the tape that is holding the leading
edge of the paper before you use it. Do not
load paper while the tape is still attached and
feed it into the equipment. There is a risk of
damaging the equipment.

(2)

When loading paper, cut the
leading edge of the paper straight
before loading it.

 Do not cut at an angle, do not cut black
marks, and do not cut labels. Depending
on the size and shape of the leading edge,
there is a risk of skewing the print position,
not being able to print, or damaging the
equipment.

Cut off the part of the paper on
which there is leftover adhesive.

 Standard media and continuous labels
(dry edge)

Note
 There is a risk of adhesive being left over
after removing the tape. If paper that still
has adhesive on it is fed into the equipment,
the adhesive may stick to the feed path and
damage the equipment.
Cutting off the part of
the paper on which there
is leftover adhesive (2)

Tape is removed (1)

Adhesive from tape

 Standard media (with black marks) and
continuous labels (dry edge)
1.2 to 4.0 mm
(0.0472 to 0.1575
inches)
Length of leading
margin when paper
is loaded
BM
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1.2 to 4.0 mm
(0.0472 to 0.1575
inches)
Length of leading
margin when paper
is loaded
BM

Preparing Paper

 Die-cut label paper (no black marks)
1.2 to 6.5 mm
(0.0472 to 0.2559 inches)
Length of leading liner
when paper is loaded

 Die-cut label paper (with black marks)
1.2 to 4.0 mm
(0.0472 to 0.1575 inches)
Length of leading margin
when paper is loaded
BM

BM
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Loading Media

Loading Media
Load the paper onto the Unwinder. For paper sizes and types that can be loaded on the Unwinder, see
“Roll Paper Specifications” (P.12).
Note
 When setting roll paper, be careful not to drop it. As roll paper is heavy, when you drop it, there is a risk of injury.
 If you drop roll paper, it may roll on the floor and cause injury to the people around.
 To prevent roll paper from dropping, store it horizontally on a desk, etc.
 Do not use any roll paper that is not specified by the Roll Paper Specifications.

Memo
 If the printer is turned OFF, press the <POWER> button to turn it on.

1

Open the Flange Locking Lever.

2

Remove the flange.

3
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Rotate the Roll Paper Holder Knob to
contract the Roll Paper Holder shaft.

Loading Media

4

Slide roll paper onto the Roll Paper
Holder shaft as far as it will go.

6

Aligning the Flange with the Roll Paper
Holder shaft as shown in the illustration,
attach the Flange.

7

Slide the Flange as far as it will go in
accordance with the roll paper width.

Note
 Make sure to slide the roll paper as far as it will go.
Insufficiently sliding the roll paper can adversely
affect print position accuracy.

Note

 Take care to avoid pinching your fingers or hands
when sliding the roll paper.

5

 Slide the Flange up to the side of the loaded roll
paper.

Rotate the Roll Paper Holder Knob to fix
the roll paper core in place.

Note
 Rotate the Roll Paper Holder Knob until it clicks.
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 Take care to avoid pinching your fingers or hands
when attaching the Flange.

Loading Media

8

Close the Flange Locking Lever.

9

Lower the Unwinder Cover Open Lever
to open the Unwinder Cover.
Open the Unwinder Cover manually in
the direction indicated by the arrow
until it locks.

Note
 After loading roll paper, take care not to rest your
body weight on the top of the Roll Paper Holder
shaft. Doing so risks causing injury due to the
device falling.

Note
 Open the Unwinder Cover until it locks securely.
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Loading Media

10

Before loading the paper, rotate the Roll
Paper Guide Adjustment Knob clockwise
and move the Roll Paper Guide towards
you.

13

Pass paper below the Tension Bar and
F0 Roller, and align the leading edge of
the paper with the Roll Paper Guide and
Paper Guide.
Roll Paper Guide
*D shape metallic pin

11

Pull up the F0 Roller Release Lever.

12

Press the Tension Bar Open Lever
upwards until it clicks.

14
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Paper Guide

Check the paper status from the
direction indicated by the arrow.

Loading Media

15

Rotate the Roll Paper Position
Adjustment Dial to adjust the paper
until it is straight.

17

Roll Paper Position
Adjustment Dial

C

18

A

Press down on the Tension Bar Open
Lever until it clicks.

After loading the paper, rotate the
Roll Paper Guide Adjustment Knob
counterclockwise and align the Roll
Paper Guide to the width of the paper.
Note

D

 Set the Roll Paper Guide correctly. If the Roll Paper
Guide is not set correctly, the width of the paper
cannot be detected correctly.

B

 Be careful that the Roll Paper Guide does not press
too strongly on the paper. Doing so could damage
the paper.

Memo

16

 Do not allow too much of a gap between the paper
and the Roll Paper Guide. Doing so could allow the

 If you rotate the Roll Paper Position Adjustment Dial
in
direction A→the roll paper moves in the direction C
direction B→the roll paper moves in the direction D

Lower the F0 Roller Release Lever to fix
the roller in place.
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paper to twist and the print position to shift.
 When setting the Roll Paper Guide to the width of
the paper, rotate the Roll Paper Guide Adjustment
Knob counterclockwise, as shown in the following
diagram, to make the Roll Paper Guide narrower
so it matches the width of the paper. If it is too
narrow, rotate the Roll Paper Guide Adjustment
Knob clockwise to first open the Roll Paper Guide
wider, and then make it narrower.

Loading Media

19

Close the Unwinder Cover.

Note
 When closing the Unwinder Cover, there is a risk of
pinching your fingers or hands. Press the top of the
Unwinder Cover to close it.

Gap is too large

This completes setting roll paper.
Memo
 If, even though the roll paper is set correctly, the
paper separates from the Unwinder Paper Guide
during printing, rotate the Roll Paper Position
Adjustment Dial in the B direction to adjust it so the
paper does not separate from the Unwinder Paper
Guide.
As a guideline, the adjustment should be the same
distance that the paper is separated from the
Unwinder Paper Guide.
Each notch on the adjustment scale at the base of
the Roll Paper Position Adjustment Dial is 1 mm.

A
Roll Paper Guide is aligned to width of paper

B

Adjustment notches

Roll Paper Guide is too tight
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Calibrating the Sensor

Calibrating the Sensor
Note

`

 Check the position of the sensor each time you load paper.
Check the position of the sensor in the following cases especially.
- When you load a different type of paper
- When you switch the type of sensor from black mark sensor to gap sensor
- When you switch the type of sensor from gap sensor to black mark sensor
 If the sensor position settings do not match, paper feed jams may occur, you cannot adjust the black mark sensor or the gap
sensor, and the skew in the adjusted values may cause the print position to skew.

Confirming the Sensor
Position
Unwinder

1

Lower the Unwinder Cover Open Lever
to open the Unwinder Cover.
Open the Unwinder Cover manually in
the direction indicated by the arrow
until it locks.
Note
 Open the Unwinder Cover until it locks securely.
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Calibrating the Sensor

2

If the position of the black mark
and the black mark sensor position
do not align, rotate the Sensor
Position Adjustment Dial to adjust
the position (go to step 3).

Confirm the sensor position.
Sensor Position Adjustment Dial

Position During Regular Usage
Factory setting is this position.
10 mm from
edge of paper
Edge of
The “∆” indicates the
black mark sensor
paper
position

Black mark (on back
side of paper)

The black mark sensor position is
set 10 mm from the edge of the
paper.
If the black mark is 15 mm or
more from the edge of the paper,
you do not need to adjust it.

The “│” indicates 16.5 mm
the gap sensor
from edge
position
of paper

(1)

If the black mark is 15 mm or less
from the edge of the paper, adjust
the position of the ∆ so it is in the
center of the black mark.

Edge of
paper

(2)

Check the black mark sensor
position
Align the paper, and check the
actual position of the black mark
and the black mark sensor position.

Check the gap sensor position
Align the paper, and check the
actual position of the label and the
gap sensor position.

Liner
Label
Black mark (on back
side of paper)
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Calibrating the Sensor

If the position of the label and the
gap sensor position do not align
in relation to the regular usage
position, rotate the Sensor Position
Adjustment Dial to adjust the
position (go to step 3).

3

Rotate the Sensor Position Adjustment
Dial to adjust the sensor position.

B
A
C
D
Memo
5mm

Width of the
right edge
of the liner
Label

The gap sensor position is set 16.5
mm from the edge of the paper.
If the width of the right edge of
the liner is 10 mm or less, then
adjustments are not necessary.
If the width of the right edge of the
liner is 10 mm or more, then adjust
the gap sensor using the above
positions as a rough estimate.
If the corners of the label are
rounded, then consider the position
of the radius of the corner.
Refer to the following example of
adjusting the position.

5mm
Radius of
corner
Label
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 If you rotate the Sensor Position Adjustment Dial in
direction A→the sensor position moves in the
direction C
direction B→the sensor position moves in the
direction D

Calibrating the Sensor

Printer

2

Confirm the sensor position.
Sensor Position Adjustment Dial

Position During
Regular Usage
Factory setting
is this position.

Remove the Print Cartridge Set and the
Belt Unit.

65 mm from
edge of paper

of paper

Edge
of
paper

Memo
 Refer to “Maintenance Guide” for the procedure to
install the print cartridge set and belt unit.

The “│” indicates the
gap sensor position
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The “ ” indicates the
black mark sensor
position

∆

1

Grasping the Top Cover Open Lever,
open the Top Cover.

3

Calibrating the Sensor

(1)

4

Check the black mark sensor
position
Confirm the center of the black
mark on the media and the black
mark sensor position on the device
(number on the  indicator).
If the position of the black mark
and the black mark sensor position
do not align, rotate the Sensor
Position Adjustment Dial to adjust
the position (go to step 4).
The black mark sensor position is
set, at the factory, to 58.5 mm from
the right edge of the label liner.

(2)

Center of black mark

Check the gap sensor position
Confirm the center of the label
on the media and the gap sensor
position on the device (number on
the | indicator).
If the position of the label and
the gap sensor position do not
align, rotate the Sensor Position
Adjustment Dial to adjust the
position (go to step 4).
The gap sensor position is set, at
the factory, to 65 mm from the
right edge of the label liner.
Adjust the position of the “ | ” so it
is in the center of the labels of the
media you are using.

Center of label

A
B

C
D

Memo
 If you rotate the Sensor Position Adjustment Dial in
direction A→the sensor position moves in the
direction C
direction B→the sensor position moves in the
direction D

Adjust the position of the “” so it
is in the center of the black mark
of the media you are using.

Black mark
(on back side or paper)

Rotate the Sensor Position Adjustment
Dial to adjust the sensor position.
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Calibrating the Sensor

Sensor Calibration

1
2

6

Click [Sensor Adjustment].

Click [Start] and select [Control Panel]
in [Windows System].
Click [View devices and printers].

Memo
 [Sensor Adjustment] appears if the following
conditions are met.

3
4

- The Media Form is one of the following
Continuous Paper (Black Mark)
Die-cut Label (Gap)
Die-cut Label (Black Mark)
Continuous Label (Black Mark)

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

- The [Ports] of the printer driver is USB or
standard TCP/IP port
 Before performing [Sensor Adjustment], make sure
that the printer is “online”.

On the [Setup] tab, click [User-defined
paper].

 If [Sensor Adjustment] does not appear, advance to
step 12 of this procedure.

7

5

Input information about the paper you
want to register. To adjust settings that
are already registered, select the names
of the paper from the list in [Registered
user-defined paper].
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Click [Next].

Memo
 Before performing the next steps of this procedure,
make sure that paper is loaded.
 If there are no paper size settings configured on the
control panel, it may cause a paper size mismatch
on the device. Pressing the <OK> button on the
control panel overwrites the device paper size
setting with the paper size setting in the printer
driver.

Calibrating the Sensor

8

Select a registration location (a) for
the adjustment, and then enter a
registration name (b).

10

When the completion screen appears,
click [Complete].

(a)

(b)

Memo
Memo
 You can enter up to eight alphanumeric English
characters for the registration name.

9

Click [Next].
This starts the sensor adjustment and
displays a wait message.

11
12
13
14
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 The results of adjusting the sensor are registered
on the printer. In [Sensor settings] in [User-defined
paper] in the printer driver, you can specify the
number registered in the printer for the adjustment
results and whether to apply it when printing. By
standardizing the registration numbers of the sensor
adjustment results, you can get the same print
results by specifying the same number in [Sensor
settings] in the printer driver for any printer. This is
useful when printing on the same media on multiple
printers.

To register new settings, click [Add] or
click [Overwrite] to select paper that is
already registered.
Click [OK] or [Close] as many times
as necessary to exit the “Printing
preferences” screen.
Open the file to be printed.

Specify a registered paper size, and
then print.

Calibrating the Sensor

If You Cannot Set the Sensors from the Printer Driver
If you cannot set the sensors from the printer driver, then set them from the control panel.

Black Mark Sensor

Gap Sensor

Confirm the sensor position

Confiure the sensor type

Confiure the sensor type

Media form = Continuous Paper (Black Mark)
Die-cut Label (Black Mark)
Continuous Lable (Black Mark)

Media form = Die-cut Label (Gap)

Confiure the paper size

Confiure the paper size

Paper size = Custom
X Dimensio = Input the “label width”
For die-cut labels (Black Mark):
Paper Length = Input the “label length”
Gap Length = Input the “gap length”
Otherwise:
Black Mark Interval = Input the “length beween
black marks”

Paper size = Custom
X Dimensio = Input the “label width”
Y Dmension = Input the “label length”
Gap Length = Input the “gap length”

Execute sensor calibration
Sensor Calibration
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Execute

Calibrating the Sensor

Calibrating the Black Mark
Sensor

5

Press the <Fn> key, and then press the
following buttons: <9>, <0>, <OK>.

6

On the Paper Size menu, select
[Custom], press the <OK> button, and
then press the <ON LINE> button.
The display will return to the standby
screen.

7

Press the <Fn> key, and then press the
following buttons: <9>, <1>, <OK>.

8

Use the numeric keypad to enter the
label width, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

You can adjust the black marks on roll paper
using the black mark sensor.
Here, we will show the method when Continuous
Label (Black Mark) are used.

1

Press the <Fn> key.

2

Press <8>, <9>, <1> (function
numbers), and then press the <OK>
button.

3

4

The numerical values input screen will
be displayed.

Select [6. Continuous Label (Black
Mark)], and then press the <OK>
button.

Press the <ON LINE> button to return
to the standby screen.
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Calibrating the Sensor

9

Press the <Fn> key, and then press
the following buttons: <8>, <9>, <0>,
<OK>.

13

Select the setting number of the sensor
to be configured, and then press the
<OK> button.

10

Select [Black Mark Interval] from
[Unwinder Config], and then press the
<OK> button.

14

Select [Execute Calibration], and then
press the <OK> button.

11

Use the numeric keypad to enter the
Black Mark Interval, press the <OK>
button, and then press the <ON LINE>
button.
The display will return to the standby
screen.

15

Enter the sensor calibration name, and
then press the <OK> button.

Memo

12

Press the <Fn> key, and then press
the following buttons: <8>, <9>, <3>,
<OK>.

16

17
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 You can leave the name blank, if you want.

If an execution confirmation screen
appears, select [Yes].

This executes sensor calibration.

Calibrating the Sensor

18

Calibrating the Gap Sensor

After sensor calibration is complete,
press the <OK> button.

You can adjust the distance between die cut
labels using the gap sensor.

1

Press the <Fn> key.
The numerical values input screen will
be displayed.

2

Press <8>, <9>, <1> (function
numbers), and then press the <OK>
button.

3

Select [3. Die-cut Label (Gap)], and
then press the <OK> button.

4

Press the <ON LINE> button to return
to the standby screen.
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Calibrating the Sensor

5

Press the <Fn> key, and then press the
following buttons: <9>, <0>, <OK>.

9

Press the <Fn> key, and then press the
following buttons: <9>, <2>, <OK>.

6

On the Paper Size menu, select
[Custom], press the <OK> button, and
then press the <ON LINE> button.
The display will return to the standby
screen.

10

Use the numeric keypad to enter the
label length, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

7

Press the <Fn> key, and then press the
following buttons: <9>, <1>, <OK>.

11

Press <8>, <9>, <0> (function
numbers), and then press the <OK>
button.

8

Use the numeric keypad to enter the
label width, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

12

Select [Gap Length] from [Unwinder
Config], and then press the <OK>
button.

- 41 -

Calibrating the Sensor

13

Use the numeric keypad to enter the
gap length, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

14

From here, perform the same steps as
those under “Calibrating the Black Mark
Sensor” from step 12 of this procedure.
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Detecting the Interval between Pages

Detecting the Interval between Pages

6

 When executing from the printer
driver
You can use the following procedure, from the
printer driver, to register the paper gap and black
mark interval on the device. Registering these
settings improves your printing results. However,
it does waste approx. 10 sheets of paper.

1
2
3
4
5

For [Paper settings], select the paper
settings you registered, and then click
[Paper interval detection].

Click [Start] and select [Control Panel]
in [Windows System].
Memo

Click [View devices and printers].

 [Paper interval detection] is displayed if the
following conditions are met.
- The Media Form is one of the following
Continuous Paper (Black Mark)
Die-cut Label (Gap)
Die-cut Label (Black Mark)
Continuous Label (Black Mark)

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].
On the [Setup] tab, click [User-defined
paper].

- The [Ports] of the printer driver is USB or
standard TCP/IP port

After confirming that the paper name
you entered in the “Paper Name” box is
shown under [Registered user-defined
paper], click [Close].

 If [Paper interval detection] does not appear,
advance to step 8 of this procedure.

7

Confirm the displayed paper
information, and then click [Measure].

This starts checking the media pitch
and closes the dialog box.
Memo
 If you change to another type of paper, you should
execute this paper interval detection again.

8

Click [OK] as many times as necessary
to exit the “Printing preferences”
screen.

9
10

Open the file to be printed.
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Specify a registered paper size, and
then print.

Detecting the Interval between Pages

 When executing from the control
panel
Detect the paper gap and black mark interval
from the control panel.

1

For black mark media, execute steps
1 to 11 in “Calibrating the Black Mark
Sensor” (P.38).
For gap media, execute steps 1 to 13 in
“Calibrating the Gap Sensor” (P.40).

2
3

Press the <Fn> key.

4

Select [Execute], and then press the
<OK> button to start paper interval
detection and close the dialog box.

Press <8>, <9>, <4> (function
numbers) and then press the <OK>
button.
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Printing

Printing
After loading the paper, use the computer to open the file you want to print. Next, use the printer driver
to select the [Paper Size] and [Paper Weight], and then print.
Memo
 When printing on label paper for the first time, execute [Sensor Adjustment] before printing.
 When reprinting after an error occurs, if Cut Mode is set, the media may not be cut in the position you expect.
If you want to align the cut positions, temporarily cancel printing, and then send the print data starting from the page you
want to reprint.

Reference
 For detailed explanations of the printer driver setup items, see “Online Help”.
 For information about how to load paper, see “Loading Media” (P.24).

 Windows PCL Printer Driver

7

Here, we will show how to print an open
WordPad file as an example.

1
2
3
4
5

Select [Page Setup] in the [File] menu.
Select the paper size and print
orientation, and then click [OK].
On the [File] menu, click [Print] >
[Print].
Click [Preferences].
On the [Setup] tab, configure [Paper
settings].

Memo
 Configure the [Cut Mode] setting on the [Setup] tab
as required.

6

When the settings are complete, click
[OK] in the “Setup” screen.
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Click [Print] in the “Print” screen to
print.

Canceling a Print Job

Canceling a Print Job
Use the procedure below to cancel a print job from the printer’s control panel.

1

On the control panel, press the
<CANCEL> button.

2

If a verification message appears, select
[Yes], and then press the <OK> button.
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3
Print Function
Settings
Printer Driver Functions Table ……… 48
Table of Setting Items
in the Control Panel Menu Screen … 50
Saving Toner When Printing .............. 79
Fine Quality Printing ..........................81
Adjusting the Print Position
on the Paper .....................................84
Other Print Functions ........................ 87
Deleting or Updating a
Printer Driver .................................... 98

Note
 The examples in this chapter use Windows WordPad for explanations. Depending on the
application, the screens and operations procedures may differ.
 For detailed explanations of the printer driver and utility setup items, see "Online Help".
 Due to printer driver and utility version upgrades, actual operations may be different from the
descriptions in this manual.
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Printer Driver Functions Table

Printer Driver Functions Table
This section explains the convenient functions when printing from a PC.
Reference
 For detailed explanations of the printer driver setup items, see "Online Help".

[User-defined paper]

Explanation of Functions
Windows PCL Printer Driver Functions
[Setup] Tab

Item
Paper Name

Description
Enter the name of the paper
settings you want to register.

Registered user- Shows a list of paper settings
defined paper
that have been registered.

Item
Example

Description
Shows what printing results
will be based on current
settings. This example is just
an approximation and does not
indicate the exact actual number
of print pages and cut positions.

Size

Specifies either millimeters
or inches as the unit for input
values.

Print position
correction

Adjusts the print start position
on the paper edge.

Cut position
correction

Adjusts the cut position when
cutting and printing roll paper.

Paper settings

Specifies, from among
registered paper settings,
which one should be applied for
printing.

Media Form

Specifies the paper setting type
to be registered.
Size input items change in
accordance with this setting.

Orientation

Specifies the print orientation.

Media Type

Specifies the paper type.

Copies

Specifies the quantity to be printed.

Media Weight

Specifies the paper thickness.

Cut Mode

Specifies the timing to cut roll paper
when cutting and printing on it.

Sensor settings

Quality

Specifies the resolution during
printing.

Specifies the settings, from
among those registered on the
device, to be used for printing.

Screen

Specifies the halftoning available
with the device.

Sensor
Adjustment

User-defined
paper

Click when using the driver to
register paper settings to be
used for printing.

Click to calibrate the gap of
black mark or die-cut labels, and
register the results as device
sensor settings.
This button is not displayed for
media forms that do not require
calibration.

Paper interval
detection

Before printing to black mark or
die-cut labels, click to execute
learning on the device to
improve the print position before
starting.
Note that executing this function
will cause some paper to be used.

Printer
information
acquisition

Obtains, from devices, the
names of settings registered as
sensor settings and the names
of user types registered as
paper types, and reflects them
in the sensor settings and paper
type list on the printer driver.

About

Displays the printer driver
version information.

Default

Restores default settings.
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[Color] Tab

Item
Color Mode

[Extend] Tab

Description

Item

Selects either color printing
or monochrome printing.
When color is selected,
clicking [Detail] displays the
"Detail" dialog box, which can
be used to configure detailed
color printing settings.

Spot Color

Specifies how white toner
should be used for printing.

Toner Saving

Specifies the print density
when economizing on toner.

[Overlays] Tab

Item
Overlays

Description
Specifies whether or not a
form should be overlaid on the
document to be printed, or
whether the document should be
registered as a new form in the
device.
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Description

Watermarks

Sets when implementing
stamp printing.

Fonts

Configures TrueType and
printer font settings.

Table of Setting Items in the Control Panel Menu Screen

Table of Setting Items in the Control Panel Menu
Screen
Device Setup Screen
Item

Description

Configuration

View device information (total number of sheets, remaining consumable quantity,
system information, etc.)

Print Information

Print the settings, usage report, error log, color profile list, and user media lists for
this machine.

Menus

Used to configure system settings, print position adjustment, color, and other
settings.

Admin Setup

Administrator sets the network settings, changes passwords, etc.

Print Statistics

Check the print use status of the user.

Calibration

Used to adjust the color densities and shades, color misalignment, etc.

Boot Menu

Set whether or not to restart the printer when a malfunction occurs in the HDD or
file system, etc.

[Configuration]
Item

Description

Feeder Count

Unwinder

nnnnnn

Displays the total print quantity for the unwinder. (This
is the number of sheets converted into the A6 size paper
from the length of paper fed from the unwinder.)

Supplies Life

Cyan Print Cartridge

Remaining
nnn%

Shows the remaining service life (%) of each color's print
cartridge.

Magenta Print Cartridge Remaining

nnn%

Yellow Print Cartridge

Remaining
nnn%

Black Print Cartridge

Remaining
nnn%

White Print Cartridge

Remaining
nnn%

Waste Toner Box

Remaining
nnn%

Shows the remaining service life (%) of the waste toner
box.

Belt

Remaining
nnn%

Shows the remaining service life (%) of the belt unit.

Fuser

Remaining
nnn%

Shows the remaining service life (%) of the fuser unit.
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Table of Setting Items in the Control Panel Menu Screen

Item
Network

System

Description

Printer Name

********** Shows the printer name used by the DNS and Network
********** PnP.
***********

Short Printer Name

*******
********

Displays the short printer name.

IPv4 Address

xxx.xxx.xxx.
xxx

Shows the IP address. When TCP/IP is enabled, shows the
setup of the following control panel setting [Admin Setup]
> [Network Setup] > [IPv4 Address].

Subnet Mask

xxx.xxx.xxx.
xxx

Displays the subnet mask. When TCP/IP is enabled, shows
the setup of the following control panel setting [Admin
Setup] > [Network Setup] > [Subnet Mask].

Gateway Address

xxx.xxx.xxx.
xxx

Displays the gateway address. When TCP/IP is enabled,
shows the setup of the following control panel setting
[Admin Setup] > [Network Setup] > [Gateway Address].

MAC Address

xx:xx:xx:
xx:xx:xx

Shows the MAC address.

Network FW Version

xx.xx

Shows the network firmware version.

Web Remote Version xx.xx

Shows the web page version.

IPv6 Address (Local) xxxx:xxxx:xx
xx:xxxx:xxxx
:xxxx:xxxx:x
xxx

Shows the (local) IPv6 address. This menu is not displayed
when TCP/IP is disabled or when the IP version is IPv4.

IPv6 Address
(Global)

xxxx:xxxx:xx
xx:xxxx:xxxx
:xxxx:xxxx:x
xxx

Shows the (global) IPv6 address. This menu is not
displayed when TCP/IP is disabled or when the IP version
is IPv4.

Serial Number

xxxxxxxxxx
xxxxxxxxxx
xxxxxx

Displays the serial number.

Asset Number

xxxxxxxxxx
Displays the asset number of the printer manager.
xxxxxxxxxx
xxxxxxxxxxxx

Firmware Version

xxx.xx_x_x

Shows the version number of FirmSuite.

CU Version

xx.xx

Displays the control unit firmware version.

PU Version

xx.xx.xx

Displays the printer unit firmware version.

RAM

xxMB

Shows the total availability of all mounted RAM.

Flash Memory

xxMB[Fxx]

Displays the total availability of all flash memory and flash
system versions installed.

HDD

xx.xxGB [Fxx] Displays the HDD size and file system version installed.

Date and Time

mm/dd/yyyy
or
dd/mm/yyyy

Displays the current date and time.
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[Print Information]
Item
Configuration

Description
Execute

Prints the device setup details.

Execute

Prints the demo pages.

Execute

Prints the file list.

Execute

Prints the total print results.

Error Log

Execute

Prints the error log.

Color Profile List
*2
User Media List

Execute

Prints the color profile list.

Execute

Prints the user media list.

Test Print-1

Execute

Prints the patterns for analyzing the print quality.

Test Print-2

Execute

Prints the patterns for analyzing the CMYK print
quality.

Test Print-3

Execute

Prints the patterns for analyzing the status of the
print cartridges.

Test Print-4

Execute

Prints the patterns for analyzing print quality of the
spot colors.

Cleaning Page

Execute

Prints the toner-free white sheet to remove dirt
from the surface of the fuser belt in the fuser unit.

Demo Page
File List
Usage Report

DEMO1
*1

*1: Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.
*2: Displayed when the user media is registered.
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Table of Setting Items in the Control Panel Menu Screen

[Menus]
 Unwinder Config
 Shaded areas are factory-set values.

Item

Value

Specifies the shape of the roll paper.

Liner Width
Mode

Auto
Custom

Liner Width

29.4 millimeter
(1.16 inch)

Specifies the mode for setting the width
of the label’s liner.
Auto:
The width of the liner is set given that
the label is in the center of the liner.
Custom:
The width of the liner is input and the
left gap is calculated given that the left
and right gaps are different.
Inputs the width of the liner.
Appears when the [Liner Width Mode] is
[Custom].

～

Liner Width Config

Description

Continuous Paper
Continuous Paper
(Black Mark)
Die-cut Label (Gap)
Die-cut Label (Black
Mark)
Continuous Label
Continuous Label
(Black Mark)

Media Form

The initial values vary depending on your
operating environment.

～

105.6 millimeter
(4.16 inch)
109.0 millimeter
(4.29 inch)
130.0 millimeter
(5.12 inch)
2.0 millimeter
(0.08 inch)

Specifies the distance from the right edge
of the label to the right edge of the liner.

～

Right Gap

Paper Size

25.4 millimeter
(1.00 inch)

～

X Dimension

25.4 millimeter
(1.00 inch)
A6
4x6 inch
Custom

The initial values vary depending on your
operating environment.
Sets the width of the custom paper sizes
for the unwinder.
Sets the dimension perpendicular to the
paper feed direction.
The initial values vary depending on your
operating environment.

～

101.6 millimeter
(4.00 inch)
105.0 millimeter
(4.13 inch)

Sets the size of the paper for the
unwinder.

126.0 millimeter
*1
(4.96 inch)
*1: 130.0 mm (5.12 inch) if the [Media Form] is [Continuous Paper] or [Continuous Paper (Black Mark)]
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Table of Setting Items in the Control Panel Menu Screen
 Shaded areas are factory-set values.

Item

Value
12.7 millimeter
(0.50 inch)

～

Y Dimension

～

101.6 millimeter
(4.00 inch)

～

148.0 millimeter
(5.83 inch)
152.4 millimeter
(6.00 inch)
1320.8 millimeter
(52.00 inch)

15.9 millimeter
(0.63 inch)

～

Black Mark Interval

～

101.6 millimeter
(4.00 inch)

～

151.2 millimeter
(5.95 inch)
155.6 millimeter
(6.13 inch)
1324.0 millimeter
(52.13 inch)
3.0 millimeter
(0.12 inch)

～

Gap Length

10.0 millimeter
(0.39 inch)

～

-0.5 millimeter
(-0.02 inch)
0.0 millimeter
(0.00 inch)

～

Adjust Cut Position

+0.5 millimeter
(+0.02 inch)
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Description
Sets the length of the custom paper sizes
for the unwinder.
Sets the same direction as for the
dimension in the paper feed direction.
If the setting is 101.6 mm (4.00 inch) or
lower, then the set page length is handled
as a whole-number multiple of the actual
length of the page such that it exceeds
101.6 mm (4.00 inch).
The initial values vary depending on your
operating environment.
Appears when the Media Form is
[Continuous Paper], [Die-cut Label
(Gap)], [Die-cut Label (Black Mark)] or
[Continuous Label].
Sets the interval of the marks on custom
paper for the unwinder.
Sets the same direction as for the
dimension in the paper feed direction.
If the setting is 104.8 mm (4.13 inch) or
lower, then the set page length is handled
as a whole-number multiple of the actual
length of the page such that it exceeds
101.6 mm (4.00 inch).
The initial values vary depending on your
operating environment.
Appears when the Media Form is
[Continuous Paper (Black Mark)] or
[Continuous Label (Black Mark)].
Sets the interval for labels.
Sets the same direction as for the
dimension in the paper feed direction.
Appears when the Media Form
is [Die-cut Label (Gap)] or
[Die-cut Label (Black Mark)].
Specifies the compensation value for
the distance from the print completion
position to the cut position (beginning of
next label). (Specifies margin on following
edge)
If you specify a negative value, cutting is
done at a short position.

Table of Setting Items in the Control Panel Menu Screen
 Shaded areas are factory-set values.

Item
Media Type

Media Weight

Sensor Setting

Value

Description

Plain
Plain Labels
Glossy Labels
Film Labels1
Film Labels2
Film1
Film2
*1
USERTYPE1
*1
USERTYPE2
*1
USERTYPE3
*1
USERTYPE4
*1
USERTYPE5
*1
USERTYPE6
*1
USERTYPE7
*1
USERTYPE8
*1
USERTYPE9
*1
USERTYPE10
*1
USERTYPE11
*1
USERTYPE12
*1
USERTYPE13
*1
USERTYPE14
*1
USERTYPE15
*1
USERTYPE16
*1
USERTYPE17
*1
USERTYPE18
*1
USERTYPE19
*1
USERTYPE20
Light
Medium Light
Medium
Medium Heavy
Heavy
Ultra Heavy1
Ultra Heavy2
Ultra Heavy3

Sets the type of the paper for the
unwinder.

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Sets the sensitivity of the gap sensor or
black mark sensor.
Only the adjusted sensor setting is
displayed.

*1: USERTYPE 1 to 20 are displayed when they are registered.
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Sets the thickness of the paper for the
unwinder.

Appears when the [Media Form] is
something other than [Continuous Paper]
or [Continuous Label].
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Item

Executes calibration of the gap sensor or
black mark sensor.

Adjust
Slice
Level

0

Fine tunes the sensitivity of the reflective
sensor in the unwinder that was measured
during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.
Appears when the black mark sensor is
used.

Reflective
Sensor in
Unwinder

Reflective
Sensor in
Printer

～

Execute

1023

0
1023

Fine tunes the sensitivity of the reflective
sensor in the device that was measured
during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.
Appears when the black mark sensor is
used.

Transmission 0
Sensor in
Unwinder
1023

Fine tunes the sensitivity of the
transmission sensor in the unwinder that
was measured during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.
Appears when the gap sensor is used.

Transmission 0
Sensor in
Printer
1023

Fine tunes the sensitivity of the
transmission sensor in the device that
was measured during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.
Appears when the gap sensor is used.

～

Check Media Pitch

Description

Execute Calibration

～

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

～

Sensor
Calibration

Value

Change Name

Execute

You can change the name of the specified
setting numbers.
You can use up to eight characters of
single-byte upper case English and
numbers.

Reset Setting

Execute

Initializes the content of the specified
setting numbers.

Execute

Measures the intervals on the paper.
Appears when the [Media Form] is
something other than [Continuous Paper]
or [Continuous Label].
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 Cutter Setup
 Shaded areas are factory-set values.

Item

Value
Job
Collation
Specified Interval

Cut Interval

1

Specifies the cutting operation.
Job:
Cuts at the end of a job.
Collation:
Cuts at the end of the job and at the end of the job collation.
Specified Interval:
Cuts in units of the specified number of pages. Cuts at the end
of the collation/job.
Sets how many pages are cut each time.
Appears when the [Cut Mode] is [Specified Interval].

～

Cut Mode

Description

9999
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 System Adjust
 Shaded areas are factory-set values.

Item

Value

Description

Power Save Time

1 minute
2 minutes
3 minutes
4 minutes
5 minutes
10 minutes
15 minutes
30 minutes
60 minutes

Sets the time until the printer enters power save
mode.

Auto Power Off Time

1 hour
2 hours
3 hours
4 hours
8 hours
12 hours
18 hours
24 hours

Sets the time until the printer enters OFF mode
from stand-by status.

Clearable Warning

ONLINE
Job

Sets the timing until clearable warning display turns
OFF.

Timeout InJob

Off
5 seconds
10 seconds
20 seconds
30 seconds
40 seconds
50 seconds
60 seconds
90 seconds
120 seconds
150 seconds
180 seconds
210 seconds
240 seconds
270 seconds
300 seconds

Sets the time from loss of the receipt of data until
force-printing.
With PS, the job is canceled without printing.

Timeout Local

0 seconds
5 seconds

Sets the time for each port to be kept opened after
printing. (Excludes network)

～

40 seconds

～

290 seconds
295 seconds
300 seconds
0 seconds
5 seconds

Sets the time for the network port to be kept
opened after printing.

～

Timeout Network

90 seconds

～

290 seconds
295 seconds
300 seconds

Error Report

On
Off

Hex Dump

Execute
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Specifies whether to print error reports when an
internal PCL or PS error occurs.
Prints received data in QR code.
Turn off the power to stop printing the hex dump.
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 Print Adjust
 Shaded areas are factory-set values.

Item
X Adjust

0.00 millimeters
+0.1 millimeters

～

Print Position
Adjust

Value

Adjusts the overall image print position perpendicularly
(horizontally) in the direction of paper feed (0.1 mm
intervals).

～

+2.00 millimeters
-2.00 millimeters

Description

Y Adjust

-0.1 millimeters
0.00 millimeters
+0.1 millimeters

Adjusts the overall image print position in the direction of
paper feed (vertically) (0.1 mm intervals).

～

+2.00 millimeters
-2.00 millimeters
-0.1 millimeters
Mode1
Mode2
Off

～
Paper Edge Detect Mode

Roll Paper End Detect Mode

Auto
Stop
Forced Cut

Media Transfer Setting Black

0
+1
+2
+3
-3
-2
-1

Media Transfer Setting Color

0
+1
+2
+3
-3
-2
-1

Set the action of the controls for the leading edge of the
media to avoid image skew and detection position skew
of the leading edge of labels.
Mode1:
For long leading edges, this setting automatically cuts/
outputs and then starts printing. For short leading
edges, printing just starts. (Applicable for the gap/
black mark setting)
Mode2:
For short or long leading edges, this setting
automatically cuts/outputs and then starts printing for
both situations.
(Applicable for the gap/black mark setting if the
leading edge is long. If the leading edge is short, then
only the gap setting is applicable.)
Off:
With this mode, the user straightens the leading edge
so paper is not wasted. (Applicable for the gap/black
mark setting)
Sets the control for ejecting the trailing edge of the
paper to auto, stop feeding, or forced cut.
Auto:
With this mode, the trailing edge is processed
appropriately according to the media.
Stop:
With this mode, feed is forced to stop when the trailing
edge of the paper is detected, regardless of the length
or type of media.
Forced Cut:
With this mode, the system is forced to cut and eject
the paper when the trailing edge of the paper is
detected, regardless of the length or type of media.
Performs fine adjustment if black is faded or tiny white
spots appear when printing with the black (K) print
cartridge only (when printing with the YMCW print
cartridges are raised).
Lower the setting value if there are only fewer white
spots, or raise the setting value if the high-density
portion is thinner.
Performs fine adjustment if colors are faded or tiny
white spots appear when printing with two or more print
cartridges or just the white (W) print cartridge.
Lower the setting value if there are only fewer white
spots, or raise the setting value if the high-density
portion is thinner.
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 Shaded areas are factory-set values.

Item
0

～

Cyan

～

+3
-6
-1

～

0

～

Magenta

+3
-6
-1

～

0

～

Yellow

+3
-6
-1

～

0

～

Black

+3
-6
-1

～

0

White

+3
-6

～

SMR Setting

Value

-1

Description
Compensates for uneven print density due to
temperature and humidity, and printing quantity, using
cyan. Raise the setting value if it is blurred. Lower the
setting value if the density darkens partially.
* Continued use with the setting value raised has a risk
of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
Compensates for uneven print density due to
temperature and humidity, and printing quantity, using
magenta. Raise the setting value if it is blurred. Lower
the setting value if the density darkens partially.
* Continued use with the setting value raised has a risk
of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
Compensates for uneven print density due to
temperature and humidity, and printing quantity, using
yellow. Raise the setting value if it is blurred. Lower the
setting value if the density darkens partially.
* Continued use with the setting value raised has a risk
of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
Compensates for uneven print density due to
temperature and humidity, and printing quantity, using
black. Raise the setting value if it is blurred. Lower the
setting value if the density darkens partially.
* Continued use with the setting value raised has a risk
of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
Compensates for uneven print density due to
temperature and humidity, and printing quantity, using
white. Raise the setting value if it is blurred. Lower the
setting value if the density darkens partially.
* Continued use with the setting value raised has a risk
of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
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Item

Value

Description

Cyan

0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences
in the temperature and humidity, using cyan. Lower the
setting value if the underlay is dark.
* Continued use with the setting value lowered has a risk
of printing stains.

Magenta

0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences
in the temperature and humidity, using magenta. Lower
the setting value if the underlay is dark.
* Continued use with the setting value lowered has a risk
of printing stains.

Yellow

0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences
in the temperature and humidity, using yellow. Lower the
setting value if the underlay is dark.
* Continued use with the setting value lowered has a risk
of printing stains.

Black

0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences
in the temperature and humidity, using black. Lower the
setting value if the underlay is dark.
* Continued use with the setting value lowered has a risk
of printing stains.

White

0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences
in the temperature and humidity, using white. Lower the
setting value if the underlay is dark.
* Continued use with the setting value lowered has a risk
of printing stains.

Drum Cleaning

On
Off

Sets whether to implement drum cleaning before
printing. The image quality may be improved.

Transfer Roller Cleaning

Execute

Implements cleaning of the 2nd transfer roller unit.

BG Setting
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Item

Value

Description

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and
dark streaks appear for cyan, green and blue toner.
Raise the setting value if the high-density portion of
cyan, green and blue is thinner.

Magenta Transfer 0
+1
Setting
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and
dark streaks appear for magenta and/or red toner.
Raise the setting value if the high-density portion of
magenta and/or red is thinner.

Yellow Transfer
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and
dark streaks appear for yellow toner.
Raise the setting value if the high-density portion of
yellow is thinner.

Black Transfer
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and
dark streaks appear for black toner.
Raise the setting value if the high-density portion of
black is thinner.

White Transfer
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and
dark streaks appear for white toner.
Raise the setting value if the high-density portion of
white is thinner.

DV Roller Cleaning 1

On
Off

Adjust the toner disposal threshold.
On:
Image quality priority
Off:
Toner life priority

DV Roller Cleaning 2

Mode 1
Mode 2
Off

May be effective against lateral striping caused by
variations in ambient temperature and/or humidity. Try
mode 2 if desired results are not produced by mode 1.

Transfer
Setting

Cyan Transfer
Setting
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[Admin Setup]
Note
 To enter this menu, it is necessary to enter the [Password].
 The factory default setting of the administrator password is [999999].

 Network Setup
 Shaded areas are factory-set values.

Item
TCP/IP
NetBIOS over TCP
IP Address Set

*1

*1

Value

Description

Enable
Disable

Enables/disables TCP/IP protocols.

Enable
Disable

Enables/disables NetBIOS over TCP/IP.

Auto
Manual

Specifies whether to request the IP address
from the DHCP server.

IPv4 Address

*1 *2

xxx.xxx.xxx.
xxx

Sets the IP address.

Subnet Mask

*1 *2

xxx.xxx.xxx.
xxx

Sets the subnet mask.

xxx.xxx.xxx.
xxx

Sets the gateway address.

Enable
Disable

Enables/disables access using web browsers.

Enable
Disable

Enables/disables access using Telnet.

Enable
Disable

Enables/disables access using FTP.

Gateway Address
Web

*1

Telnet
FTP

*1 *2

*1

*1

IPSec

*1

Enable
Disable

Enables/disables access using IPsec.

SNMP

*1

Enable
Disable

Enables/disables access using SNMP.

Network Scale

Normal
Small

Gigabit Network

Enable
Disable

Normal:
Printer operates effectively even if
connected to a hub with spanning tree
functions. However, printer startup
time becomes longer when two or three
computers are connected to a small-scale
LAN.
Small:
Covers small scale LANs with 2 or 3 PCs
to large scale LANs are covered, but if
connected to a hub with spanning tree
functions, operations may not be effective.
Sets whether to support a Gigabit network.

Hub Link Setting

Auto Negotiate Sets the connection mode to the hub.
100Base-TX Full
100Base-TX Half
10Base-T Full
10Base-T Half

Network Factory Defaults

Execute

*1: Appears when [Enable] is set on the control panel for [TCP/IP].
*2: Appears when [Manual] is set on the control panel for [IP Address Set].
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Restores the settings, such as network, mail
server, LDAP server, and secure protocol
server, etc., to their default values.
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 USB Setup
 Shaded areas are factory-set values.

Item

Value

Description

USB

Enable
Disable

Enables/disables access using a USB interface.

Speed

480Mbps
12Mbps

Sets the maximum baud rate using a USB interface.

Soft Reset

Enable
Disable

Enables/disables the software reset command.

Serial Number

Enable
Disable

Enables/disables the USB serial number.
The USB serial number is used to identify USB
devices connected to a PC.

Offline Receive

Enable
Disable

Sets whether to receive data even if offline or a
recoverable error occurs.

- 64 -

Table of Setting Items in the Control Panel Menu Screen

 Print Setup
 Shaded areas are factory-set values.

Item

Value

Description

Auto
PCL
PostScript

Select the print language. Print language switching
is automatic when set to [Auto].

Copies

1

Sets the copy quantity.
This setting is ignored in case of local print.
This setting is disabled unless the [Job Copy]
setting is 1.
Sets the print quantity.
This setting is ignored in case of local print.
The settings in the printer driver always overwrite
these settings.

～

Personality

9999
1

～

Job Copy

999

* This setting is enabled only if [Collate] is checked
and 1 is specified as the number of copies in the
PCL printer driver.
Edge to Edge

On
Off

Sets the print margin.

Resolution

600dpi
1200dpi

Sets the resolution.

Toner Save Level

Off
Low
Middle
High

Set the toner save quantity.
Specifies [Off] when toner save mode is disabled.

Color

All
Except 100%
Black

All:
All colors, including 100% black, comprise all the
target colors for toner saving.
Except 100% Black:
All colors, excluding 100% black, comprise all the
target colors for toner saving.

Check Unnecessary Print Cartridge

On
Off

Set whether to generate an error or continue
printing when a print cartridge is detected to
be down even though it is not being used as a
specified color for the print data.
On:
An error is displayed and the print job is
cancelled, to give priority to the service life of
the print cartridge.
Off:
A warning screen is displayed, but printing
continues because priority is given to
productivity.

Default Orientation

Portrait
Landscape

Sets the print orientation.

Trapping

Off
Narrow

Sets trapping.

Toner Save

Narrow /
Choke White
Wide
Wide / Choke
White
Choke White
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 PS Setup
 Shaded areas are factory-set values.

Item

Value

Description

Network Protocol

ASCII
RAW

Specifies the PS communication protocol mode for
data from the network.

USB Protocol

ASCII
RAW

Specifies the PS communication protocol mode for
data from USB.

 PCL Setup
 Shaded areas are factory-set values.

Item
Font Source

Value
Resident

Description
Sets the location of the fonts to be used.

Downloaded
Font Number

I0
S1

Sets the numbers of the fonts to be used.

0.44 CPI

Sets the font width.
Increases and reduces in 0.01 CPI units.
Displayed when the font selected using [Font
Number] is an outline font with fixed spacing.

～

Font Pitch

*1

10.00 CPI

～

99.99 CPI

Font Height

4.00 points

～

12.00 points

999.75 points
PC-8
Select the symbol set.
PC-8 Dan/Nor
PC-8 Grk
PC-8 TK
PC-775
PC-850
PC-851 Grk
PC-852
PC-855
PC-857 TK
PC-858
PC-862 Heb
PC-866
PC-866 Ukr
PC-869
PC-1004
Pi Font
Plska Mazvia
PS Math
PS Text
Roman-8
Roman-9
Roman Ext
Serbo Croat1
Serbo Croat2
Spanish
UCS-2
Ukrainian
VN Int'l
VN Math
VN US
Win 3.0
Win 3.1 L/G
Win 3.1 Blt

～
Symbol Set

Sets the font height.
Increases and reduces in 0.25 point units.
Displayed when the font selected using [Font
Number] is an outline font with variable spacing.

*1: Refer to “Resident Fonts” (P.71) about the Font Number to be used.
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Item
Symbol Set

Value

Description

Win 3.1 Cyr
Select the symbol set.
Win 3.1 Grk
Win 3.1 Heb
Win 3.1 L1
Win 3.1 L2
Win 3.1 L5
Wingdings
Dingbats MS
Symbol
OCR-A
OCR-B
OCRB Subset2
HP ZIP
USPSFIM
USPSSTP
USPSZIP
Bulgarian
CWI Hung
DeskTop
German
Greek-437
Greek-437 Cy
Greek-737
Greek-8
Greek-928
Hebrew NC
Hebrew OC
Hebrew-7
Hebrew-8
IBM-437
IBM-850
IBM-860
IBM-863
IBM-865
ISO Dutch
ISO L1
ISO L2
ISO L4
ISO L5
ISO L6
ISO L9
ISO Swedish1
ISO Swedish2
ISO Swedish3
ISO-2 IRV
ISO-4 UK
ISO-6 ASC
ISO-10 S/F
ISO-11 Swe
ISO-14 JASC
ISO-15 Ita
ISO-16 Por
ISO-17 Spa
ISO-21 Ger
ISO-25 Fre
ISO-57 Chi
ISO-60 Nor
ISO-61 Nor
ISO-69 Fre
ISO-84 Por
ISO-85 Spa
ISO-Cyr
ISO-Grk
ISO-Hebrew
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Item

Value

Description

Symbol Set

Kamenicky
Legal
Math-8
MC Text
MS Publish
PC Ext D/N
PC Ext US
PC Set1
PC Set2 D/N
PC Set2 US

Select the symbol set.

CR Function

CR
CR+LF

Specifies the operation when a CR code is received.

LF Function

LF
LF+CR

Specifies the operation when an LF code is
received.

Print Margin

Normal
1/5 inch
1/6 inch
1/8 inch
1/12.5 inch

Sets the area of the paper where printing is not
possible.

True Black

On
Off

Specifies whether to use mixed CMYK or black
toner only for printing black of image data.

Pen Width Adjust

On
Off

Compensates so that thin lines are visible.

 Color Setup
 Shaded areas are factory-set values.

Item

Value

Description

Ink Simulation

Off
SWOP
ISO Coated
Japan

Sets the ink simulation. This setting is enabled only
for PS language jobs.

UCR

Low
Normal
High

You can select the black plate (black) amount
during color printing.
Setting more black plate economizes on the toner
of the other three colors.

CMY 100% Density

Enable
Disable

Enables/disables 100% output for CMY 100% shade
values.

CMYK Conversion

On
Off

You can select the method of total toner quantity
control for CMYK data. Select [Off] to disable GCR
(Gray Component Replacement). Furthermore, this
menu setting is disabled if using the ink simulation
function.
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 Panel Setup
 Shaded areas are factory-set values.

Item

Value

Description

Supplies Life

Sets the information displayed in the standby
screen.

Panel Brightness During Operation

5

Adjusts the brightness (backlight luminosity) of the
control panel LCD.
The set brightness is applied during control panel
operations.

～

Idle Display

31
Panel Brightness While Power Save

Adjusts the brightness (backlight luminosity) of the
control panel LCD.
The set brightness is applied after the panel
backlight timer time has elapsed from the last
operation.

～～

0
1

31
Panel Backlight Timer

Adjusts the time (in seconds) from the last
operation until [Panel Brightness While Power Save]
is applied.

～

10

～

30
300

 Time Setup
 Shaded areas are factory-set values.

Item

Value

Date Format

Description
Sets the date display mode.
The initial values vary depending on your
operating environment.

yyyy/mm/dd
mm/dd/yyyy
dd/mm/yyyy
-12:00

Sets the time difference from GMT in 15-minute
units. If the time zone setting is changed, the
time differences before and after the change are
reflected in the current time.

～

Time Zone

～

+0:00

Daylight Saving

+13:00
On
Off

Time Setting

2000/01/01 00 :00

Sets whether to display daylight saving time.
On:
Sets the current time 1 hour forward.
Off:
Sets the current time 1 hour back.

～

Sets the time.

2091/12/31 23 :59

 Power Setup
 Shaded areas are factory-set values.

Item

Value

Description

Power Save

Enable
Disable

Enables/disables power save mode.

Auto Power Off

Enable
Auto Config
Disable

Sets auto power off mode.
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 Others Setup
 Shaded areas are factory-set values.

Item

Language
Setup

Job Cancel
Setup

Receive Buffer Size

Auto
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the incoming buffer size that is assured by the
local interface.

Resource Save

Auto
Off
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the resource saving area size.

Check File System

Execute

Implements management data (FAT information)
recovery, and resolves mismatches between the
actual (free) space in the file system and the free
space displayed.

Check All Sectors

Execute

Recovers defective sector information on the HDD and
file system nonconformances.

Enable Initialization

No
Yes
Chinese
English
French
German
Italian
Japanese
Russian
Spanish

Specifies whether or not to authorize setup changes
associated with HDD and flash memory initialization.

Language Initialize

Execute

Deletes the message files that have been downloaded.
Also, the [Select Language] setting returns to the
factory default setting.

Cancel Key Behavior

Short
Long
Off

Sets the operations when the device <CANCEL>
button is pressed.
Short:
Hold down no longer than two seconds to cancel the
print job.
Long:
Hold down for 2 to 5 seconds to cancel a print job.
Off:
Disables the <CANCEL> button.

Inquiry Display

On
Off

Sets whether to display the enquiry screen when a
job is canceled.

Focus Position

Yes
No

Sets whether to apply [Yes] or [No] focus for selection
in the job cancellation enquiry screen.

Display Timeout

60

Sets the display timeout value for the enquiry screen
when a job is canceled.

Select Language

180

Specifies the control panel display language.

～

Storage
Common
Setup

Description

300

～

RAM Setup

Value
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Item
Media
Operation
Setup

Value

Description

Inquiry Display

On
Off

Specifies the operation when the <FEED> button or
the <UNLOAD> button is pressed.
On:
In the cases below, a confirmation screen is
displayed before the operation is executed.
<FEED>: When the paper changes from a stand-by
state to a through paper state
<UNLOAD/CUT>: When cut is executed
Off:
Operation is performed without displaying a
confirmation message.

Rewinder Distance

600 millimeter
(24 inch)
900 millimeter
(36 inch)
1200 millimeter
(48 inch)

Specifies the amount to be fed when the <FEED>
button is pressed in the stand-by state, using the
output slot as the reference point.

Feed Distance

150 millimeter
(6 inch)
300 millimeter
(12 inch)
450 millimeter
(18 inch)

Specifies the amount to be fed when the <FEED>
button is pressed in the through paper state, using
the current position as the reference point.

 Settings
 Shaded areas are factory-set values.

Item

Value

Description

Reset Settings

Execute

Restores the user menu settings to the factory
settings.

Save Settings
*1
Restore Settings

Execute

Saves the current menu settings.

Execute

Changes the saved menu settings.

*1: Displayed when [Save Settings] is executed on the control panel.

 Change Password
 Shaded areas are factory-set values.

Item

Value

Description

New Password

************ Sets a new password to be entered in the [Admin
menu] and [Boot Menu].

Verify Password

************ Sets a new password to be entered in the [Admin
menu] and [Boot Menu] for which [New Password]
has been set.

 Resident Fonts
Item

Font Name List

I0

Courier

I1

Courier Bold

I2

Courier Italic

I3

Courier Bold Italic

I4

CG Times

I5

CG Times Bold

I6

CG Times Italic

I7

CG Times Bold Italic

I8

CG Omega
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Item

Font Name List

I9

CG Omega Bold

I10

CG Omega Italic

I11

CG Omega Bold Italic

I12

Coronet

I13

Clarendon Condenced

I14

Univers Medium

I15

Univers Bold

I16

Univers Medium Italic

I17

Univers Bold Italic

I18

Univers Medium Condensed

I19

Univers Bold Condensed

I20

Univers Medium Condensed Italic

I21

Univers Bold Condensed Italic

I22

Antique Olive

I23

Antique Olive Bold

I24

Antique Olive Italic

I25

Garamond Antique

I26

Garamond Halbfett

I27

Garamond Kursiv

I28

Garamond Kursiv Halbfett

I29

Marigold

I30

Albertus Medium

I31

Albertus Extra Bold

I32

Letter Gothic

I33

Letter Gothic Bold

I34

Letter Gothic Italic

I35

Arial

I36

Arial Bold

I37

Arial Italic

I38

Arial Bold Italic

I39

Times New

I40

Times New Bold

I41

Times New Italic

I42

Times New Bold Italic

I43

ITC Avant Garde Gothic Book

I44

ITC Avant Garde Gothic Demi

I45

ITC Avant Garde Gothic Book Oblique

I46

ITC Avant Garde Gothic Demi Oblique

I47

ITC Bookman Light

I48

ITC Bookman Demi

I49

ITC Bookman Light Italic

I50

ITC Bookman Demi Italic

I51

Courier PS

I52

Courier PS Bold

I53

Courier PS Oblique

I54

Courier PS Bold Oblique

I55

Helvetica
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Item

Font Name List

I56

Helvetica Bold

I57

Helvetica Oblique

I58

Helvetica Bold Oblique

I59

Helvetica Narrow

I60

Helvetica Narrow Bold

I61

Helvetica Narrow Oblique

I62

Helvetica Narrow Bold Oblique

I63

New Century Schoolbook Roman

I64

New Century Schoolbook Bold

I65

New Century Schoolbook Italic

I66

New Century Schoolbook Bold Italic

I67

Palatino Roman

I68

Palatino Bold

I69

Palatino Italic

I70

Palatino Bold Italic

I71

Times Roman

I72

Times Bold

I73

Times Italic

I74

Times Bold Italic

I75

ITC Zapf Chancery Medium Italic

I76

Symbol

I77

Symbol PS

I78

Wingdings

I79

ITC Zapf Dingbats

I80

OCRB Subset2

I81

Line Printer

I82

OCR-A

I83

OCR-B

I84

USPS POSTNET Bar Codes

 Scalable: 81 fonts (No.I0-80)
 Bitmap: 4 fonts (No.I81-84)
 Total 85 fonts
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[Print Statistics]
Note
 To enter this menu, it is necessary to enter the [Password].
 In the default factory settings, the password is [0000].
 Shaded areas are factory-set values.

Item
Usage Report
Supplies Report

Description
Enables/disables the Usage Report function.

Enable
Disable

Sets whether or not to display the number of
consumables replacements.

Execute

Resets the main counter aggregate value.

Execute

Resets the number of consumables replacements.

New Password

****

Sets the new password to be entered in [Print
Statistics].

Verify Password

****

Sets a new password to be entered in the [Print
Statistics] for which [New Password] has been set.

*1

Reset Main Counter

*1

Reset Supplies Counter
Change
*1
Password

Value
Enable
Disable

*2

*1: Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.
*2: Not displayed if [Disable] is set for the control panel [Supplies Report] item.
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[Calibration]
 Shaded areas are factory-set values.

Item

Value

Description

Auto Density Mode

On
Off

Sets whether to automatically compensate density
and shade.

Adjust Density

Execute

Implements density compensation. Implement
when the device is in stand-by status.

Adjust Registration

Execute

Color Density

-3

Implements auto color misalignment compensation
operations. Implement when the device is in standby status.
Adjusts the cyan density.
This setting is enabled from printing after the
density compensation has been implemented.

～

Cyan Density

～

0
+3

Adjusts magenta density.
This setting is enabled from printing after the
density compensation has been implemented.

-3

～

Magenta Density

～

0
+3

Adjusts yellow density.
This setting is enabled from printing after the
density compensation has been implemented.

-3

～

Yellow Density

～

0
+3

Adjusts black density.
This setting is enabled from printing after the
density compensation has been implemented.

-3

～

Black Density

～

0
+3

Adjusts white density.
This setting is enabled from printing after the
density compensation has been implemented.

-3

～

White Density

～

0
+3
Print Color Tuning Pattern

Execute

Prints patterns to match the shading characteristics.

Base Color
Tuning

A-1
A-2
B-1
B-2

Matches the color balance for the parts displayed as
most clear in the highlight area of the printed color
tuning pattern.
The matching results are reflected in the highlight
matching values for cyan, magenta, and yellow
matching.

～

Highlight

O-1
O-2
A-1
A-2
B-1
B-2

Matches the color balance for the parts displayed as
most clear in the mid-tone area of the printed color
tuning pattern.
The matching results are reflected in the mid-tone
matching values for cyan, magenta, and yellow
matching.

～

Mid-Tone

O-1
O-2
A-1
A-2
B-1
B-2

Matches the color balance for the parts displayed
as most clear in the dark area of the printed color
tuning pattern.
The matching results are reflected in the dark
matching values for cyan, magenta, and yellow
matching.

～

Dark

O-1
O-2
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 Shaded areas are factory-set values.

Item

Value

Description
Matches the highlights (light areas) of the cyan
shade characteristics.

-4

～

Cyan Tuning Highlight

～

0
+4

Matches the intermediate areas of the cyan shading
characteristics.

-4

～

Mid-Tone

～

0
+4
-4

Matches the dark (dark areas) of the cyan shade
characteristics.

～

Dark

～

0
+4
-4

Matches the highlights (light areas) of the magenta
shading characteristics.

～

Highlight

0

～

Magenta
Tuning

+4
Matches the intermediate areas of the magenta
shading characteristics.

-4

～

Mid-Tone

～

0
+4

Matches the dark (dark areas) of the magenta
shading characteristics.

-4

～

Dark

～

0
+4
Highlight

Matches the highlights (light areas) of the yellow
shading characteristics.

-4

～

Yellow
Tuning

～

0
+4
Matches the intermediate areas of the yellow
shading characteristics.

-4

～

Mid-Tone

～

0
+4
Matches the dark (dark areas) of the yellow shading
characteristics.

-4

～

Dark

～

0
+4
Matches the highlights (light areas) of the black
shading characteristics.

-3

～

Black Tuning Highlight

～

0
+3
Matches the intermediate areas of the black
shading characteristics.

-3

～

Mid-Tone

～

0
+3
Matches the dark (dark areas) of the black shading
characteristics.

-3

～

Dark

0

～

Fine Color
Tuning

+3
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 Shaded areas are factory-set values.

Item

Value

Description

Reset Color Tuning

Execute

Resets CMYK color matching.

White Tuning

-3

Matches the highlights (light areas) of the white
shading characteristics.

～

Highlight

～

0
+3
Matches the intermediate areas of the white
shading characteristics.

-3

～

Mid-Tone

～

0
+3

Matches the dark (dark areas) of the white shading
characteristics.

-3

～

Dark

～

0
+3
Density Adjustment Media

Standard Media
Narrow/Thick
Media
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Specifies the operation speed during a density
adjustment operation.
Standard Media:
Density adjustment operation performed at
normal speed.
Narrow/Thick Media:
Density adjustment operation performed at low
speed.

Table of Setting Items in the Control Panel Menu Screen

[Boot Menu]
Note
 This menu is displayed in English only.

 Boot Menu
Note
 To enter this menu, press and hold the <OK> button while turning ON the power supply.
 Confirm that [Boot Menu] is selected and then press the <OK> button.
 To enter this menu, it is necessary to enter the [Password].
 The factory default setting of the administrator password is [999999].
 Shaded areas are factory-set values.

Item
Storage
Common
Setup

Value

Description

Check File System

Execute

Executes management data (FAT information)
recovery, and resolves mismatches between the
actual (free) space in the file system and the
displayed free space.

Check All Sectors

Execute

Recovers defective sector information on the HDD
and file system nonconformances.

Menu Lockout

On
Off

Specifies whether or not to display menus on the
control panel.

Panel Lockout

Mode1
Mode2
Off

Sets whether to disable the operations buttons on
the control panel.

 Troubleshooting
Note
 To enter this menu, press and hold the <OK> button while turning ON the power supply.
 Select [Troubleshooting] and then press the <OK> button.

Item
Sensor Calibration Reset

Value
Execute
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Description
This resets all sensor calibration results to initial
values.

Saving Toner When Printing

Saving Toner When Printing
Saving Toner When 
Printing (Toner Save
Mode)
You can print by economizing the toner
consumption amount by reducing the page print
density. Separately enable or disable the toner
economy mode for 100% black.

Windows PCL printer driver

1
2
3
4

Open the file to be printed.

Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Color] tab, use [Toner Saving]
to select a toner save quantity.

Memo
 You can suppress the quantity of toner used by selecting
one of the following five patterns as necessary to reduce
toner density.
- Printer setting: Follows the printer’s setup.
- Off: Prints using regular density without economizing
the toner.
- Save Level Low: Prints using medium light toner.
- Save Level Middle: Prints using light toner.
- Save Level High: Prints using considerably light toner.
 [Toner Saving] is enabled only if the print quality is
specified as [Normal] or [Draft].
 The settings on the printer can be changed from [Admin
Setup] > [Print Setup] > [Toner Save]. However, the
printer driver settings are given priority.

5

Note
 Toner save mode is not compatible with Spot Color
printing.
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Saving Toner When Printing

Printing Using the Specified Print Cartridge Only (Lift Up)
The lifespan of an unused print cartridge can be prolonged by separating it from the belt unit.
Setting combinations are shown in the table
below.
Print Color

3

Turn the lift up lever on the print
cartridge that is not being used
clockwise to raise the print cartridge.

4

Close the top cover.

Print Cartridge to be
Lifted Up

Black (K) only

Cyan, magenta, yellow,
white*

White* (W) only

Black, cyan, magenta,
yellow

Black + white*

Cyan, magenta, yellow

Black, cyan, magenta,
yellow

White*

Example: Printing using the CMYK Print Cartridge
only
In this example, the White (W) Print Cartridge is
lifted up.

1

Grasping the Top Cover Open Lever,
open the Top Cover.

Note

2

 When closing the Top Cover, there is a risk of
pinching your fingers at the Top Cover support point
and Top Cover. Press the top of the Top Cover to
close it.

Check the position of the unused print
cartridge via the label letters and color.

 When closing the Top Cover while grasping the LED
head, there is a risk of pinching your fingers or
hands. Press the top of the Top Cover to close it.
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Fine Quality Printing
Making Photograph
Printing More Vivid (Photo
Enhance)

Changing Print Quality
(Resolution)
Set [Quality] by aligning to the environment in
which it is used.

You can print more natural and vivid images,
such as photos, etc.

Memo

Note

 Selecting [Fine/Detail(1200x1200 dpi)] prints at the
highest quality available with the printer.

 This function can be used with Windows PCL printer
drivers only.

 Windows PCL Printer Driver

1
2

Open the file to be printed.

3
4

Click [Preferences] (or [Properties]).

5

 Windows PCL Printer Driver

1

Select [Print] in the [File] menu.

On the [Setup] tab, change the [Quality]
setting.

Open the file to be printed.

2
3
4

Select [Print] in the [File] menu.

5

Print.

Click [Preferences] (or [Properties]).
On the [Setup] tab, select [Photo
Enhance] in the [Quality] section, and
then click [OK].

Print.
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Adjusting Fine Lines

Using Printer Fonts

You can prevent misaligned lines being printed
when ultra-fine lines are specified from the
application.
This function is normally ON.

You can print by replacing TrueType fonts with
printer built-in fonts.
Note

Memo
 Depending on the application, bar code and other intervals
will narrow. In this case, turn OFF the function.

 Windows PCL Printer Driver

1
2

Open the file to be printed.

3
4

Click [Preferences] (or [Properties]).

Select [Print] in the [File] menu.

On the [Extend] tab, click [Advanced].

5

Select [Adjust ultra fine lines]. Next,
select [Off] for [Settings], and then
click [OK].

6

Print.

 The font replacement function stores the document
fonts, but font designs cannot be reproduced. If it is
necessary to print font designs accurately, disable the font
replacement function.
 In some applications, the font replacement function may
not work properly.

 Windows PCL Printer Driver

1
2
3
4
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Open the file to be printed.

Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
Click the [Extend] tab, and then select
[Fonts].

Fine Quality Printing

5

Using Computer Fonts

On the "Font" screen, select the [Font
Substitution] check box.
For this printer, this check box is selected as the
default setting.

You can output TrueType fonts as they appear on
the screen.
Note
 Print time may be longer.

 Windows PCL Printer Driver

6
7

Use the [Font Substitution Table] to
specify which printer fonts should
replace the TrueType fonts.

1
2
3
4
5

Open the file to be printed.
Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Extend] tab, click [Fonts].
On the "Font" screen, clear the [Font
Substitution] check box.
 Download as Outline Font
Font image is created by the printer.

Print.

 Download as Bitmap Font
Font information is created by the printer
driver.

6
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Adjusting the Print Position on the Paper

Adjusting the Print Position on the Paper
You can correct the print start position vertically and horizontally on the paper by the printer settings.
Please refer to the following procedure.

Using the roll paper

3

Press the scroll button or
item you want to adjust.

4

Press the <OK> button.

5

Press the scroll button or to select the
amount of the adjustment, and then press
the <OK> button. Confirm there is a check
mark ( ) to the left of the selected value.

to select the

Paper feed
direction

1

2

Press the <Fn> key.
The numerical values input screen will
be displayed.

Press <2>, <2>, <0> (function
numbers), and then press the <OK>
button.

Note
 Y represents the paper feed direction and X represents the
orthogonal position relative to the paper feed direction.
 Set positive [+] numbers to widen the blank space in the
X direction, and also set positive [+] numbers to widen
the blank space in the Y direction.
 Readjustment might be necessary depending on the usage
conditions (temperature, humidity, media type).
 By eliminating the differences between printers and using
the same settings on all the printers with this procedure,
you can use one computer when you want to get the
same print results on multiple printers. Refer to “Using
the Printer Driver to Fine-tune the Print Position” (P.16)
about setting the computer.
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Adjust the position using [Y Adjust] in
[Menus]>[Print Adjust]>[Print
Position Adjust].

Adjusting the Position
That Printing Starts
This section explains how to better align the
position at which printing starts for die-cut label
paper (with black mark), continuous label (with
black mark), and die-cut label paper.
This adjustment is unnecessary if your print jobs
do not require accurate positioning of where
printing starts.

1

Adjust the position that printing starts
on the first page.
After setting the size of the
mediacalibrate the sensor
and execute Paper interval
detection.

(2)

When using a black
mark sensor

When using a gap
sensor

At the point that the
black mark intersects
the position of the
black mark sensor on
the printer, measure
the distance at A from
the leading edge of
the black mark to the
printed matter on five
sheets.

At the point that
the label intersects
the position of the
gap sensor on the
printer, measure the
distance at B from
the leading edge
of the label to the
printed matter on
five sheets.

Label
paper
Printed
matter

Black mark sensor
on the printer

Gap sensor on the
printer
|



Liner

In the driver’s print settings, set [To
specify the number of pages per
cut] in [Cut Mode] and set [1] in
[Page(s) per cut].
Note

 You may not be able to set [1] in [Page(s) per
cut] if the paper on which you are printing is
shorter than 101.6 mm. If this is the case, set
the smallest value that you can select.
A

(3)

Print five pieces of the media on
which you are actually printing.

(4)

Measure the distance at A or B,
as shown in the diagram, for all
five sheets and then calculate the
average of these values.

(5)

Calculate the difference in the
position you want to print and the
average value from (4).

B

Cutting off part of
the label makes
measuring easier.

Memo
 About Print Position Adjust (Y Adjust)
Plus and minus direction for Y adjust

Direction that media is fed
If you set Y Adjust in the minus
direction, the image moves up
If you set Y Adjust in the plus
direction, the image moves down
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2

3

If you are actually printing more than
two sheets consecutively, then next, do
the following adjustment.
(Improve the accuracy of the function
for learning the position that printing
starts)

(1)

In the driver’s print settings, set [To
specify the number of pages per
cut] in [Cut Mode] and set [20] in
[Page(s) per cut].

(2)

Print 20 pieces as a test print (*).
* These printouts are test prints
for adjusting positions, so throw
them away when you are done.

The adjustments are complete when
printing is done in the position you
want.
Reset the cutter settings, and then start
printing.
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Other Print Functions
Overlaying Stamps for
Printing (Watermarks)

Specifying the Page Order
Extracts by page order when printing documents
with multiple pages.
There are two methods.

The details to be printed from the application can
be independently printed overlaying [Samples],
[Confidential], etc.

 Printing documents in page order.
 Printing documents in reverse page order.
Samples

 Windows PCL Printer Driver

1
2
3

Open the file to be printed.

4

On the [Setup] tab, select the [Print in
reverse order] check box in the [Copies]
area.

5

 Windows PCL Printer Driver
Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).

1
2
3

Open the file to be printed.

4

On the [Extend] tab, click
[Watermarks].

Print.
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Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).

Other Print Functions

5

Collating Printed Output
(Sorted Printing)

Click [New].

You can store print jobs in the device memory
and collate the printing.
Printing by specifying batches

x 2 sets

Printing without specifying batches

x 2 sets

6

On the "Watermarks" screen, enter text
into [Text], and configure [Size] and
other settings.

Note
 Not usable with some applications.

 Windows PCL Printer Driver

1
2
3
4
7
8

Open the file to be printed.
Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).

On the [Setup] tab, enter a value for
[Copies], and then select the [Collate]
check box.

Click the <OK> button.
Print.

5
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Other Print Functions

Printing a Mirror Image
Print using mirror print when you want to print
image to appear normal when the page is viewed
from the back.

10
11

 Windows PCL Printer Driver

1

Click [Start] and select [Control Panel]
in [Windows System].

2

Click [View devices and printers].

3
4
5

Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].

6
7
8

Open the file to be printed.

9

Select [Print] in the [File] menu.

Select [General] tab, and then click
[Preferences].
On the [Setup] tab, select the [Mirror
Print] check box in the [Orientation]
section, and then click [OK].

Select [Page Setup] in the [File] menu.
Select the paper size and print
orientation, and then click [OK].
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Click [OK] to return to the "Print"
screen.
Click [Print] in the "Print" screen to
print.

Other Print Functions

Printing Registered Forms
(Print Overlay)

5

On the [Overlays] tab, select [Register
print document as a new form].

You can register forms, logos, etc., as forms to
the device, and overlay for printing.

Memo
 To print an overlay, you need to create a form and register
it in advance.It is possible to specify a maximum of four
forms in one group.Forms are overlaid and printed in the
order they are registered. That is to say, the last form you
register is printed on top.

 Windows PCL Printer Driver

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Click [View devices and printers].

Memo
 If the form you want to print is already registered to
the device, you do not need to do steps 5 through 10.
Advance to step 11 of this procedure.

6

Click [Apply] > [OK] to close the
“Printing Preferences” screen.

7
8

From the application, print the image
you want to register as a form.

Click the [Overlays] tab.
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Confirm that the [New Form] screen
appears.

Other Print Functions

9

Input the [Form name] and [ID], and
then click [OK].

10
11

The form is sent to the device and
registered with the specified ID.

12

Select the forms you want to use for
overlay printing.

On the [Overlays] tab, select [Overlay
Print].

13

Perform the following operation to
close the “Printing Preferences” screen:
[Apply] > [OK].

14

Print from the application.
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Changing the Check
Unnecessary Print
Cartridge Setting

Outputting to a File
Without Printing
You can write and save to a file without printing
the print data.

You can have an error displayed and cancel
the print job to prioritize the service life of a
print cartridge that is detected to be down even
though it is not being used as a specified color
for the print data.

Note
 PC administrator privileges are required.

 Windows PCL Printer Driver

1
2

3
4
5

Click [Start] and select [Control Panel]
in [Windows System].

1

Press the scroll button

or

.

2

Select [Admin Setup], and then press
the <OK> button.

3

Enter the administrator password, and
then press the <OK> button.

Click [View devices and printers].

Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].
Select the [Ports] tab.
In the ports list, select [FILE:], and
then click [OK].

Memo
 The factory default setting of the administrator
password is [999999].

6
7

Print.
Enter the file name, and then click [OK].

- 92 -

Other Print Functions

4

Saving Printer Driver
Setups

Select [Print Setup], and then press the
<OK> button.

You can save the details set using the printer
drivers.

5

6

7

Select [Check Unnecessary Print
Cartridge], and then press the <OK>
button.

If you save the changes to the settings for
multiple locations, then the next and following
times you change the settings, all you have
to do is specify the driver settings so that
those settings in the multiple locations are
automatically changed to the settings that you
saved.

Save a Setup

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4
5

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Click [View devices and printers].

If you want an error to be generated
when a print cartridge is detected to be
down even though it is not being used
as a specified color for the print data,
select [On]. Select [Off] if you want
printing to continue. Then, press the
<OK> button.

Press the <ON LINE> button to return
to the standby screen.
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Change the settings to create the setup
you want to save.
On the [Setup] tab, click [Save].

Other Print Functions

6

7

Enter the setting name into [Save
Favorites as], and then click [OK].

Delete a Saved Setup

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4
5

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Click [View devices and printers].

Click [OK] to close the Print Setup
dialog box.

Recall a Saved Setup

1
2
3
4

Open the file to be printed.
On the [File] menu, select [Print].
Click [Preferences] (or [Properties]).
On the [Setup] tab, configure
[Favorites].

6
7
5

Print.
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On the [Setup] tab, click [Management].
Click [Delete].

Select the setup you want to delete,
and then click [Delete].
Click [Yes].

Other Print Functions

Importing/Exporting a
Printer Driver Print Setup

6

In the [List of favorite settings] on the
"Export" screen, select the checkbox
next to the setup you want to export,
and then click [Export].

7

Enter a file name, specify where to save
it, and then click [Save].

You can convert printer driver print setup
information to a file, and then export/import the
file. The file extension for exporting/importing is
".xmn".

Export a Setup

1
2

3
4
5

Click [Start] and select [Control Panel]
in [Windows System].
Click [View devices and printers].

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Import a Setup

On the [Setup] tab, click [Management].

Click [Export].

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].
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Click [View devices and printers].

On the [Setup] tab, click [Management].

Other Print Functions

5

Changing Default Printer
Driver Settings

Click [Import].

It is convenient to set frequently used settings
as the default settings.

6

On the "Import" screen, click [Open the
file].

7
8

Specify the file you want to import, and
then click [Open].

9

When the message "Imported
successfully." appears, click [OK].

Check the names of the settings in the
[List of favorite settings], and then click
[Import].

 Windows PCL Printer Driver

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].
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Click [View devices and printers].

Change the various settings, and then
click [OK].

Deleting or Updating a Printer Driver

Deleting or Updating a Printer Driver
Deleting a Printer Driver

8

Select the driver to be deleted, and
click [Remove].

9

If a message asking whether to delete
the drivers only, or the drivers and
packages from the system, select to
delete drivers and packages, and click
[OK].

10
11

If a verification message is displayed,
click [Yes].

 Windows PCL Printer Driver
Note
 PC administrator privileges are required.
 Restart the computer, and then delete the driver.

1
2

3
4

Click [Start] and select [Control Panel]
in [Windows System].
Click [View devices and printers].

Right-click the [LT5C PCL6] icon,
and then select [Remove device].
If a verification message is displayed,
click [Yes].

Note
 If a message appears while the device is in use,
restart the PC, and then perform steps 1 and 2 of
this procedure again.

5
6
7

Select one of the icons in [Devices
and Printers], and click [Print server
properties] in the top bar.
Select the [Drivers] tab.

If the [Remove Driver Package] dialog
box is displayed, click [Delete]>[OK].
Note

Click if [Change Driver Settings] is
displayed.

 If you cannot cancel, restart the PC, and then
perform steps 4 to 10 of this procedure again.

12
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Click [OK] in the [Print server
properties] dialog box.

Deleting or Updating a Printer Driver

13

Updating a Printer Driver

Restart the PC.

For information about the latest driver
versions, check the Afinia Label website.

Note
 Network Extension and the Color Swatch Utility installed
together with the printer driver are not deleted even if the
printer driver is deleted.
To delete Network Extension and the Color Swatch Utility,
use [Control Panel] > [Uninstall a program].

 Windows PCL Printer Driver
Note
 PC administrator privileges are required.

1

Download the printer driver from
the Afinia Label website.
afinialabel.com/LT5Cinfo

2
3

Double-click the file you downloaded
Select the desired language, and then
click [OK].
Memo
 When the "User Account Control" window is
displayed, click [Yes].

4
5

Read the "Software License Agreement",
and click [Accept].
Follow the instructions that appear on
the screen to finish driver installation.
Memo
 Attempting to install an old version driver will cause
an update screen to appear. Follow the instructions
that appear on the screen.
 Updating a driver may require restarting of the
computer.

6
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When the [Program Compatibility
Assistant] dialog appears, click [This
program installed correctly].

4
Adjusting the Color
Adjusting Color with the
Control Panel ...................................100
Adjusting Color with a
Printer Driver ...................................109
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Adjusting Color with the Control Panel

Adjusting Color with the Control Panel
Correcting Color Drift
Manually
The printer compensates color drift automatically
according to the conditions of use. If the color
drift is noticeable, you can also implement
compensation manually.

1

2

3

4

Press the <Fn> key.

Configuring Settings
for Auto Adjustment of
Density and Gradation
The printer compensates density automatically
according to the conditions of use. To
compensate automatically, turn [On] the density
compensation matching setting.
In the default factory settings, density
compensation matching is implemented
automatically.

The numerical values input screen will
be displayed.

1

Press the scroll button

or

.

2

Select [Calibration], and press the
<OK> button.

3

Select [Auto Density Mode], and then
press the <OK> button.

Press <3>, <0>, <1>, and press the
<OK> button.

Check that [Execute] has been selected,
and press the <OK> button.

The display will return to the standby
screen.
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4

Select [On], and then press the <OK>
button. Confirm there is a check mark
( ) to the left of [On].

Adjusting Density
Manually
The printer can implement compensation
periodically using auto density compensation
mode, but if the print density is noticeable, it
can also be compensated manually.
Memo

5

Press the <ON LINE> button to return
to the standby screen.

 Density adjustment values are set by specifying [Cyan
Density], [Magenta Density], [Yellow Density], [Black
Density], and [White Density] values with the control
panel.

1

Press the <Fn> key.

2

Press <3>, <0>, <0>, and press the
<OK> button.

3

Check that [Execute] has been selected,
and press the <OK> button.

4

Execute density adjustment.
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The numerical values input screen will
be displayed.

Adjusting Color with the Control Panel

5

The display will return to the standby
screen after density adjustment is
complete.

Fine Tuning Density
Adjustments
You can finely adjust the densities of colors
that are used as the references for density
compensation.
Adjust each color separately for the parts where
the density is noticeable from the print results.
This section describes the procedure for
adjusting the reference density for cyan. Use the
same adjustment procedure also for other colors
that you wish to adjust.
 Increasing cyan after checking the print
results

1

Press the <Fn> key.

2

Press <3>, <1>, <0>, and press the
<OK> button.

The numerical values input screen will
be displayed.

Memo
 For magenta, yellow, black, and white, use the
operations below.
- To tune magenta, press the <Fn> key, and then
press the following buttons: <3>, <1>, <1>,
<OK>.
- To tune yellow, press the <Fn> key, and then
press the following buttons: <3>, <1>, <2>,
<OK>.
- To tune black, press the <Fn> key, and then press
the following buttons: <3>, <1>, <3>, <OK>.
- To tune white, press the <Fn> key, and then
press the following buttons: <3>, <1>, <4>,
<OK>.
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3

Press the scroll button
or
to specify
a value that is larger than the current
value, and then press the <OK> button.

8

Confirm there is a checkmark ( ) to
the left of the selected value.

Memo
 Select +1 to +3 to make density darker, or -1 to -3
to make it lighter.

4

Press the <ON LINE> button to return
to the standby screen.

5

Press the <Fn> key, and then press
<3>, <0>, <0>, <OK>.

6

Check that [Execute] has been selected,
and press the <OK> button.

7

The display will return to the standby
screen.
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Print.
If you are not satisfied with the density,
repeat steps 1 to 6 of this procedure.

Adjusting Color with the Control Panel

Adjusting Color Balance
(Density)

2

Use the print results for the color tuning
pattern to check the current color
balance.

The printer can implement compensation
periodically using auto density compensation
mode. However, you can implement this
adjustment when you want to adjust the gray
balance of the halftones, which is not sufficiently
adjusted by the auto density compensation.
Note
 The densities of the colors are mutually dependent on
each other, so you will need to repeat adjustment several
times until the desired color balance is achieved.
 The results of the basic [Base Color Tuning] are reflected
in the settings in [Fine Color Tuning]. Consequently, if the
[Fine Color Tuning] are adjusted manually, these settings
will be reset, so be careful. However, the [Black Tuning]
settings are not reset.

1

Print a color tuning pattern.

(1)

Press the <Fn> key.
The numerical values input screen
will be displayed.

(1)

(2)

Press <3>, <0>, <2>, and press
the <OK> button.

Check the area to be referenced
using “Base Color Tuning”.
Check the numbers (A1,2 to O-1,2)
of the pattern that seems the
most similar to the adjacent CMY
mixed colors part and single color
K part from among the patterns
distributed in the “Highlight”,
“Mid-Tone”, or “Dark” areas.
Memo

 If the pattern that seems most similar to the
adjacent CMY mixed colors part and single color K
part in the “Highlight”, “Mid-Tone”, or “Dark” areas
matches the “Current” on the left of the color tuning
pattern, the color balance is normal and does not
require adjustment.

(3)

(4)

Check that [Execute] has been
selected, and press the <OK>
button.

3

Use the print results for the color tuning
pattern to adjust the color balance.

(1)

The color tuning pattern will be printed.
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Press the scroll button

or

.

Adjusting Color with the Control Panel

(2)

(7)

Select [Calibration], and press the
<OK> button.

The pattern number specified in
each area will be displayed.
If the pattern number is correct,
select [Yes], and press the <OK>
button.

(3)

Select [Base Color Tuning], and
press the <OK> button.
Memo
 To respecify the pattern number select [No] to
return to the "Calibration" screen.

(8)
(4)

Select [Return], and press the <OK> button
to return to the standby screen.

Specify the number of the desired
square in the "Highlight" area of the
pattern, and then press the <OK>
button.

Memo

(5)

(6)

 If the desired color balance is not obtained even
after [Base Color Tuning], adjust the CMY color
balance manually using the procedure under
[Adjusting the color balance]. For color balance
fine tuning, see “Fine-tuning Color Balance”
(P.106).

Specify the number of the desired
square in the "Mid-Tone" area of the
pattern, and then press the<OK>
button.

 If the overall tone is still too bright or too dark
even after implementing [Base Color Tuning],
adjust the black tone manually using [Fine
Color Tuning], and then implement [Basic color
Tuning] again. To brighten the overall tone,
adjust the black tone in [Fine Color Tuning] in
the - direction, and to darken the overall tone,
adjust the black tone in [Fine Color Tuning] in
the + direction.

Specify the number of the desired
square in the "Dark" area of the
pattern, and then press the <OK>
button.
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4

Check the color balance adjustment
results.

(1)
(2)

Print the color tuning pattern.
Use the print results for the
color tuning pattern to check the
adjusted results.
If the pattern that seems most
similar to the adjacent CMY mixed
colors part and single color K part
in the “Highlight”, “Mid-Tone”,
or “Dark” areas matches the
“Current” on the left of the color
tuning pattern, the color balance
adjustment is complete.

Fine-tuning Color Balance
The printer can implement compensation
periodically using auto density compensation
mode. However, you can implement this
adjustment when you want to finely adjust
the gray balance of the halftones, which is
not sufficiently adjusted by the auto density
compensation.
Note
 The densities of the colors are mutually dependent on
each other, so you will need to repeat adjustment several
times until the desired color balance is achieved.

1

Print a color tuning pattern.

(1)

Repeat steps 1 through 3 of this
procedure in accordance with the
results of your pattern check.

Press the <Fn> key.
The numerical values input screen
will be displayed.
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(2)

Press <3>, <0>, <2>, and press
the <OK> button.

(3)

Check that [Execute] has been
selected, and press the <OK>
button.

(4)

The color tuning pattern will be
printed.

Adjusting Color with the Control Panel

2

Use the print results for the color tuning
pattern to check the current color
balance.

3

Use the print results for the color tuning
pattern to adjust the color balance.
If you are adjusting the color balance,
use the control panel to specify the
shade (Highlight, Dark, and Mid-Tone)
of each color.
This section explains the procedure for
slightly darkening the cyan highlights.
Adjust the colors other than cyan in the
same way.

(1)

Press the scroll button

(2)

Select [Calibration], and press the
<OK> button.

(3)

Select [Fine Color Tuning], and
press the <OK> button.

(4)

Select [Cyan Tuning], and press
the <OK> button.

or

.

(1) Check the area to be referenced
using "Fine Color Tuning".

The color tuning pattern blocks
are arranged in four rows of 11
columns. The four rows are printed
with the following colors, from top
to bottom: [Cyan], [Magenta],
[Yellow] and [Black].
The 11 columns represent color
tone, and vertical broken lines are
labeled as [Highlight], [Mid-Tone],
and [Dark].

- 107 -

Adjusting Color with the Control Panel

(5)

Select [Highlight], and press the
<OK> button.

(6)

Specify a larger value than the
current set value, and press the
<OK> button. Confirm there is a
check mark ( ) to the left of the
specified value.

Memo
 Select +0.1 to +4.0 to make density slightly
darker, or -0.1 to -4.0 to make it slightly lighter.
Note, however, that the black adjustment ranges
are +0.1 to +3.0 and -0.1 to -3.0.

(7)

4

Press the <ON LINE> button to
return to the standby screen.

Check the color balance adjustment
results.

(1)
(2)

Print the color tuning pattern.
Use the print results for the
color tuning pattern to check the
adjusted results.

Repeat steps 1 through 3 of this
procedure in accordance with the
results of your pattern check.
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Adjusting Color with a Printer Driver
Color Matching
(Automatic)

Color Matching
What Is Color Matching?
It is important to manage the work processes
from data creation to output based on methods
with color consistency. For example, scanners,
digital cameras, and monitors, and other devices
express the blending ratio to which the light of
red, blue, and green (three colors) have been
added to black as values over the RGB color
space (additive mixture of colors).
Meanwhile, printers express the blending ratio
of the four toner colors cyan, magenta, yellow,
and black relative to white (white light), with
the three reflected colors red, blue, and green
excluded as values in the CMYK color space
(subtractive mixture of colors).
The RGB color space and CMYK color space are
color spaces dependent on the machine used,
and so when converting color spaces, the colors
will be different from the reproduced colors
unless individual machine characteristics are
taken into consideration.

To maintain color consistency from data creation
to output, it is necessary to consider the color
differences by device when converting colors.
This process is called "color matching". The
program that implements the color matching is
called the "color management system" (CMS).

The procedure below performs recommended
color matching for general documents. Generally
use the settings shown here.

 Windows PCL Printer Driver

1
2
3
4

Open the file to be printed.

5

Print.

The printer can use either printer driver color
matching or application color matching.

Note
 Even if you are using color matching, the printed colors
may appear dark compared to the colors on the monitor.
This is because the range of colors that can be reproduced
by the device is narrower than the range of colors that
can be reproduced by the monitor, so even if color
matching is used, the vivid colors on the monitor cannot
be reproduced.
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On the [File] menu, select [Print].
Click [Preferences] (or [Properties]).
In "Color" on the [Color] tab, select
[Automatic], and then click [OK].

Adjusting Color with a Printer Driver

Simple Color Matching
(Simple Adjustment)

 Setup Items

Color matching is used on a printer for
reproduction of the RGB colors required to print
from word processor, spreadsheet, presentation,
and other similar software.

 [RGB Color Setting]
Specifies the method for expressing the
colors processed using color matching.
 Monitor - Auto
During color matching, represents
color by the most ideal method
suited to the document to be printed,
emphasizing compatibility with the
monitor (color temperature 6500 K).
Normally use this setting.

Color matching is implemented using a special
accelerator (ASIC) that is built into the printer.
When converting RGB color space print data to
the printer CMYK color space, color matching
processing is applied.

 Monitor - Perceptual
During color matching, represents the
color by the method emphasizing the
gradation suiting the natural image
of the photograph and compatibility
with the monitor (color temperature
6500K).

Note
 In the case of a Windows PCL printer driver, color
matching is not applied even if [Automatic] or [Simple
Adjustment] is selected for the CMYK color space print
data. In this case, select "Graphic Pro".
 If you are installing ICC profile in Windows, click [Advanced
Setup] in the [Layout] tab, and then select [Disable ICM]
in [ICM Methods].

 Monitor - Vivid
During color matching, represents the
color by the method emphasizing the
vividness suiting the images and text,
and compatibility with the monitor
(color temperature 6500K).
 Monitor - light
During color matching, represents the
color by the method emphasizing the
gradation suiting the natural image
of the photograph and compatibility
with the monitor (color temperature
9300K).
 Adobe RGB
Specify if you are using an input device
with AdobeRGB color characteristics.
 sRGB
The sRGB colors within the printer's
color gamut are printed without any
modification. Only colors that fall
outside the printer's color gamut are
matched with the outer shell. Suitable
for matching specific colors.
 [Black Finish]
Sets the black finish when printing in color.
Normally use Auto as is.
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 Windows PCL Printer Driver

1
2
3
4

5

Color Matching
(Graphic Pro)

Open the file to be printed.
Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).
On the [Color] tab, click [Color],
select [Automatic] or [Simple
Adjustment], and then click [OK].

Graphic Pro is the optimal choice for use with
DTP software.
It lets you specify simulation printing for any
CMYK output device.
To use an ICC profile of an I/O device for color
matching, you need to register the ICC profile to
the device beforehand.

 Windows PCL Printer Driver

1
2
3
4

Open the file to be printed.

5

Print.

On the [File] menu, select [Print].
Click [Preferences] (or [Properties]).
On the [Color] tab, click [Color], then
select [Graphic Pro], and then click
[OK].

Print.
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Color Matching
(No Color Matching)
Prints using the specified colors as is, without
implementing color matching using the printer
drivers or device.
Select if implementing color matching using an
application.

Changing the Black Finish
The finish for the black parts will be changed
when printing in color. This can be used when
the printer driver's color mode setting is [Simple
Adjustment] or [Graphic Pro].

 Setup Items
 Black Finish
 Auto
Creates black using the optimum
methods according to the document to
be printed. This setting can be selected
only when the color mode is set to
[Simple Adjustment]. This setting
cannot be configured on the Graphic
Pro.

 Windows PCL Printer Driver

1
2
3
4

Open the file to be printed.
On the [File] menu, select [Print].
Click [Preferences] (or [Properties]).

 Composite Black(CMYK)
Synthesizes black using cyan,
magenta, yellow, and black toner.
The black is close to brown. Ideal for
photos.

On the [Color] tab, click [Color], then
select [No Color Matching], and then
click [OK].

 True Black (K)
Prints black using black toner only.
Ideal for diagrams and documents.
When printing photos, the dark parts
are blackish.

5

Print.

 Pure Black Text/Graphics (Graphic Pro Only)
If black defined using the RGB color space
for text and graphics (R=0, G=0, B=0) or
black defined using the CMYK color space
(C=0, M=0, Y=0, K=100%) is specified,
this setting specifies whether printing
should use black (K) toner only.
 ON
Prints the text and graphics specified
as black using black (K) toner only.
 OFF
Text and graphics specified as black
are synthesized using either black (K)
toner only or CMYK depending on the
profile specified by color matching.
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Monochrome
(Black and White) Printing

 Windows PCL Printer Driver

1
2
3
4

Open the file to be printed.

5

In the [Black Finish] section, select the
black finishing method. In the [Graphic
Pro] mode, also select ON or OFF for
[Pure Black Text/Graphics], and then
click [OK].

The color data is printed using grayscale (shades
of black and white) without touching the print
data.

On the [File] menu, select [Print].

Note

Click [Preferences] (or [Properties]).
On the [Color] tab, select [Simple
Adjustment] or [Graphic Pro], and then
click [Detail].

 If implementing color printing after printing by specifying
"Monochrome", a delay may occur depending on the
temperature adjustment of the fuser unit.

Memo
 Even if the cyan (blue), magenta (red), yellow print
cartridge life has been reached, monochrome printing
using only black can be done by specifying “Monochrome”.
 Refer to “Printing Using the Specified Print Cartridge Only
(Lift Up)” (P.80) regarding printing with black only.
 For information about roll paper, see “Roll Paper
Specifications” (P.12).

 Windows PCL Printer Driver

6

Print.

1
2
3
4

Open the file to be printed.

5

Print.
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Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Color] tab, select [Monochrome].
Adjust lightness and darkness as
required.

Adjusting Color with a Printer Driver

Suppressing White Lines
Between Text and the
Background
(Black Overprint)

Correcting for Print
Misalignment (Trapping)

If you are imaging 100% black text on a colored
background, you can print (overprint) by
overlaying the text and background parts. Set if
there are gaps such as white lines, etc., in the
borders between the text and background.
Note
 Not usable with some applications.
 Black overprint cannot be used if the text is not 100%
black, the text has been rendered as graphics by
extracting the outlines, or if the text is an image.
 If the background color is dark (toner layer thickness
exceeds 240%), toner may not be fixed completely. For
example, if printing 100% black text on backgrounds of
50% cyan, 50% magenta, and 50% yellow, the toner
layer thickness is 50+50+50+100=250%, which exceeds
240%.

 Windows PCL Printer Driver

1
2
3
4
5

Open the file to be printed.

6

Print.

Use if there are white or colored lines
between two overlapping objects due to print
misalignment.

 Windows PCL Printer Driver

1
2
3
4
5

Open the file to be printed.

6

Print.

Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Extend] tab, click [Advanced].
Select [Trapping]. Next, select the
misalignment correction method with
[Settings], and then click [OK].

Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Extend] tab, click [Advanced].
Select [Overprint Black]. Next, for
[Settings], select [On], and then click
[OK].
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Simulating Print Results
The printer adjusts CMYK color data to simulate
the characteristics of ink, such as that used in
offset printing.
The ICC profiles registered as standard are
described below.
 RGB Profiles
- sRGB
- AdobeRGB
 CMYK Input Profiles
- SWOP
- ISO Coated

 Windows PCL Printer Driver

1
2
3
4
5

Open the file to be printed.

6
7

Click [OK].

- Japan Color

Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).
On the [Color] tab, click [Detail], and
then select [Graphic Pro].
Select [Printer Simulation], and then
use the list under [Simulation Target
Profile] to select the ink characteristics
you want to simulate.

- JMPA
Note
 Enabled when [Color Mode] is set to either [Simple
Adjustment] or [Graphic Pro].
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Print.

Adjusting Color with a Printer Driver
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Spot Color Printing
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Printer Driver Spot Color
Function List ................................... 118
Printing on Color Papers.................. 119
Fine-Tuning White Shading .............. 121

Note
 The examples in this chapter use Windows WordPad for explanations. Depending on the
application, the screens and operations procedures may differ.
 For detailed explanations of the printer driver and utility setup items, see "Online Help".
 Due to printer driver and utility version upgrades, actual operations may be different from the
descriptions in this manual.
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Printer Driver Spot Color Function List

 Printer Driver Spot Color Function List
This section explains the Spot Color toner functions in the printer drivers.

 Windows PCL Printer Driver
Click the [Color] tab to display the screen for setting the spot color toner.

Item
Usage Method

Spot color
toner quantity
adjustment

Description

Do not use

Prints without using white toner.

Full page

Uses white toner for the entire page being printed.

Data portion (Excluding white)

Uses white toner for all data parts that do not include
white parts.

Data portion (Including white)

Uses white toner for all data parts that include white
parts.

Printing only spot color toner

Prints with white toner only.

Watermarks/Overlays

Prints the selected watermark and overlay with white
toner.

0 to 100

Adjusts the amount of white toner used while printing.
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 Printing on Color Papers
Usable Color Papers
Use color paper that satisfies the following
conditions.
 Pigment or ink used to color the paper heatresistant to 230ºC
 E-photo printer paper with the same paper
characteristics as plain paper

Printing Using White Toner
Only
Printing text and illustrations using only white
toner on color paper.
Before printing, check that the white print
cartridge has been mounted to the device, and
that white toner has been selected using the
printer drivers.
Memo
 If you specify "Print Only with Spot Color" and lift up all
the other colors of cartridges, you can print with only spot
colors, even if one of the black, cyan, magenta, or yellow
print cartridges has reached the end of its service life.
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Printing on Color Papers

Printing White Under Color

 Windows PCL Printer Driver

1
2
3
4

Open the file to be printed.

5
6
7
8

Click [Preferences] (or [Properties]).

When printing on color paper, print a base with
white toner, and then print in color on top of
that.

Select [Page Setup] in the [File] menu.
Select the paper size and print
orientation, and then click [OK].
Select [Print] in the [File] menu.

Use [Media Type] to select the paper
type.
Use [Media Weight] to select an
appropriate value.
Click the [Color] tab.

9

For [Usage Methods], select [Printing
only spot color toner], and then click
[OK].

10

Click [Print] in the "Print" screen to
print.

 Windows PCL Printer Driver

1
2

Open the file to be printed.

3

Select the paper size and print
orientation, and then click [OK].

4
5
6

Select [Print] in the [File] menu.

7
8

Click the [Color] tab.

9
10

Click [OK].

- 120 -

Select [Page Setup] in the [File] menu.

Click [Preferences] (or [Properties]).
Use [Paper settings] to select the paper
type.

For the [Spot Color] setting, select
one of the following: [Full page],
[Data portion (Excluding white)],
[Data portion (Including white)], or
[Watermarks/Overlays].

Click [Print] in the "Print" screen to
print.

Fine-Tuning White Shading

Fine-Tuning White Shading
Finely adjust the shade for each white highlight, dark, mid-tone gradation using the printer control
panel.
Here, we will show the procedure for slightly
darkening white highlights.

1

Press the scroll button

or

4

Select [Highlight], and press the <OK>
button.

5

Specify a value that is larger than the
current set value, and then press the
<OK> button. Confirm there is a check
mark ( ) to the left of the specified
value.

.

2

Select [Calibration], and press the
<OK> button.

3

Select [White Tuning], and then press
the <OK> button.

Memo
 A larger value represents darkening, while a smaller value
represents lightening.

6
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Press the <ON LINE> button to return
to the standby screen.

Fine-Tuning White Shading
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Initializing Network Settings

Initializing Network Settings
Note

5

Select [Network Factory Defaults], and
then press the <OK> button.

6

When [Execute] appears, press the
<OK> button.

7

Initialization is executed, and the
display returns to the standby screen.

 Implementing this operation will initialize all network
settings.

1
2

3

Press the scroll button

or

.

Select [Admin Setup], and then press
the <OK> button.

Enter the administrator password, and
then press the <OK> button.
Memo
 The factory default setting of the administrator
password is [999999].

4

Select [Network Setup], and then press
the <OK> button.
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Using DHCP
IP addresses can be acquired from a DHCP server.
Note
 PC administrator privileges are required for the setup.
 Incorrectly allocating the IP address may cause major malfunctions such as crashing of the network. Thoroughly consult the
network administrator before making the settings.

To use the device in a DHCP environment, select
[Auto] as the IP address setting method.

4

Select [Network Setup], and then press
the <OK> button.

5

Select [IP Address Set], and then press
the <OK> button.

Also note that [Auto] is the IP address setting
method under factory default settings, so
performing this procedure is normally not
necessary.

1

2

Press the scroll button

or

.

Select [Admin Setup], and then press
the <OK> button.

6
3

Select [Auto], and then press the <OK>
button.

Enter the administrator password, and
then press the <OK> button.
Memo
 The factory default setting of the administrator
password is [999999].

7
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Press the <ON LINE> button to return
to the standby screen.

Using DHCP

 To use the printer in a BOOTP
environment
To use the printer in a BOOTP environment,
select [BOOTP] as the IP address setting
method.

1

Access the printer web page and log in
as an administrator.

2
3

Select [Admin Setup].

4

Click [Submit].

Select [Network Setup] > [TCP/IP] >
[Change Settings] > [Get IP address
automatically (BOOTP)].

Memo
 Refer to “Using a Web Browser to Configure the Network
Setup” (P.141) regarding the printer web page.
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IPv6
This printer is compatible with IPv6, and the
IPv6 address is acquired automatically. IPv6
addresses cannot be set manually.
The device is compatible with the following
protocols.
 Printing:

Checking the IPv6 Address
IPv6 addresses are allocated automatically.

1

- LPR

Memo

- IPP

 Refer to “Using a Web Browser to Configure the
Network Setup” (P.141) regarding the printer web
page.

- RAW (Port9100)
- FTP
 Setup:
- HTTP

2

- SNMPv1/v3
- Telnet

Access the printer web page and select
[View information].

Select [Network] > [TCP/IP].

Memo
 If all the global addresses are displayed as "0", it is
possible an error has occurred in the router being used.

Reference
 Press the scroll button

or

, and then select [Print

Information] > [Configuration] to check the IPv6 address
using the configuration report. For reports and information
about how to print them, see “Printing Configuration
Information” (P.130).
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Printing Configuration Information

Printing Configuration Information
Printable Report List
List Name

Description

Reference
pages

Configuration

Prints the table of all menu category items and the current
settings. Further, the advanced printer settings are also printed
in the page header.

Page 131

Demo Page

Prints the demo print data stored in the printer.

Page 132

File List

Prints the file list.

Usage Report

Prints the total print results.

Page 133

Error Log

Prints the errors detected and saved by the printer.

Page 133

Color Profile List

Prints the color profile list.

Page 134

Color Adjustment Pattern

Prints the patterns to match the shading characteristics.

Page 104
Page 106

User Media List

Prints the user media list.

Page 135

Test Print-1

Prints the patterns for analyzing the print quality.

Page 135

Test Print-2

Prints the patterns for analyzing CYMK print quality.

Page 135

Test Print-3

Prints the patterns for analyzing the status of the print
cartridges.

Page 135

Test Print-4

Prints the patterns for analyzing print quality of the spot colors.

Page 135

Cleaning Page

Prints the toner-free white sheet to remove dirt from the surface
of the fuser belt in the fuser unit.

Maintenance
Guide

Page 52

 Paper is cut at a fixed length when printing a report, so do not use die-cut label paper.
 To attain the full benefit of the report printing function, load paper that is 130 mm wide.
 Printing is canceled if a print cartridge for a color that is required for report printing is not lifted down.
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Printing Printer Setup Lists

 Printing result samples

Configuration
Print the device information.
Print to see the remaining quantity of
consumables and other set values such as IP
addresses and MAC addresses, and to check
whether the printer is operating correctly, etc.

 To print

1

Press the <Fn> key.

2

Press <1>, <0>, <0> (function
numbers), and then press the <OK>
button.

3

Confirm that [Execute] is selected, and
then press the <OK> button.

The numerical values input screen will
be displayed.
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Printing Printer
Information Lists

5

Demo Page
Prints demonstration pages.

 To print

1

Press the scroll button

or

.

2

Select [Print Information], and then
press the <OK> button.

3

Select [Demo Page], and then press the
<OK> button.

4

When [DEMO1] appears, select one of
the items to be printed, and then press
the <OK> button.
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Confirm that [Execute] is selected, and
then press the <OK> button.

Printing Configuration Information

Error Log

Usage Report

Prints the history of the errors that have
occurred in the device.

Prints the total print results.
Memo

 To print

1

2

3

 Not displayed if [Usage Report] of [Print Statistics] is set
to [Disable].

Press the <Fn> key.

 To print

The numerical values input screen will
be displayed.

1

Press the <Fn> key.

2

Press<1>, <0>, <2> (function
numbers), and then press the <OK>
button.

The numerical values input screen will
be displayed.

Press <1>, <0>, <3> (function
numbers), and then press the <OK>
button.

Confirm that [Execute] is selected, and
then press the <OK> button.

3
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Confirm that [Execute] is selected, and
then press the <OK> button.

Printing Configuration Information

4

Use the numeric keypad or the scroll
buttons ( , ) to specify the number
of copies, and then press the <OK>
button.

Printing Print Lists
Color Profile List
Prints the table of the ICC profiles registered on
the printer.

 To print

1

Press the scroll button

2

Select [Print Information], and then
press the <OK> button.

3

Select [Color Profile List], and then
press the <OK> button.

4

Confirm that [Execute] is selected, and
then press the <OK> button.
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or

.
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User Media List

Test Print

Prints the table of the user media registered to
the device.

Prints the print quality lists.
 Test Print-1
Prints the patterns for analyzing the print quality.

Memo

 Test Print-2
Prints the patterns for analyzing CMYK print
quality.

 Displayed when the user media is registered.

 To print

1

Press the scroll button

or

.

 Test Print-3
Prints the patterns for analyzing the status of
the print cartridges.
 Test Print-4
Prints the patterns for analyzing print quality of
the spot colors (white).

 To print

2

Select [Print Information], and then
press the <OK> button.

3

Select [User Media List], and then press
the <OK> button.

4

Confirm that [Execute] is selected, and
then press the <OK> button.

1

Press the scroll button

2

Select [Print Information], and then
press the <OK> button.

3

Select [Test Print-1], [Test Print-2],
[Test Print-3], or [Test Print-4], and
then press the <OK> button.
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or

.

Printing Configuration Information

4

When [Execute] appears, press the
<OK> button.

Changing the
Administrator Password
Change the administrator password. The factory
default setting is [999999].

1

Press the scroll button

2

Select [Admin Setup], and then press
the <OK> button.

3

Enter the administrator password, and
then press the <OK> button.

4

Select [Change Password], and then
press the <OK> button.
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or

.

Printing Configuration Information

5

Enter the new password, and then press
the <OK> button.
Note
 Specify a password that is at least six characters
long.

6

Re-enter the new password, and then
press the <OK> button.

7

Press the <ON LINE> button to return
to the standby screen.
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Checking the Print Count

Checking the Print Count
You can check the quantity of paper printed from the unwinder to date.

1

Press the scroll button

or

.

2

Select [Configuration], and then press
the <OK> button.

3

Select [Feeder Count], and then press
the <OK> button.

4

Select the feeder you want to check.

5

Press the <OK> button.

6

Press the <ON LINE> button to return
to the standby screen.
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Utility List

 Utility List
Utility Name

Description

Operating Environment

Reference
pages

Web Browser

Can be used to view messages
displayed on the printer, and to
configure network settings and other
settings.

Computer with Microsoft
Internet Explorer, Safari,
Google Chrome, or
Firefox installed

Page 153

Network Extension

Can be used to check printer setup
items from a printer driver and to
configure option settings.
This utility is installed automatically
when a printer driver is installed on
a network connection.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008/
Computer running TCP/IP

Page 190
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 Using a Web Browser to Configure the Network
Setup
Operating Environment

Starting Up

Computer with Microsoft Internet Explorer,
Safari, Google Chrome, or Firefox installed

1
2

Computer running TCP/IP
Memo
 Check to make sure that the security setting of the web
browser is MEDIUM.

The explanation here is based on the example
environment described below.
 Printer name:

Start up the web browser.
In the address bar, enter the following
URL then press [Enter]: http://<printer
IP address>/.

This displays the printer status screen.

LT5C

Note

 Printer IP address: 192.168.0.2
 MAC Address:

00:80:87:84:9C:9B

 Web Browser:

Microsoft Internet Explorer
Ver.11

 If the IP address includes a one-digit or two-digit
number, do not enter leading zeros. Doing so may cause
communication problems.
Example: Correct: http://192.168.0.2/
Incorrect: http://192.168.000.002/
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Logging in as an
Administrator

3

Specify the configuration information
that can be checked on the network,
and then click [OK] or [SKIP].

Note
 To change printer settings using a web browser, you need
to log in as a printer administrator.

1

Click [Administrator Login].

Note
 You can skip configuring settings by clicking [SKIP].
 Selecting the [Do not show this page again]
checkbox, and then clicking [OK] or [SKIP] will
cause this page not to be displayed any more.

2

For [Username] enter "root", for
[Password] enter the current password,
and then click [OK].

4

Memo

 The password is the same as the control panel
"Administrator Password".
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This will display the screen below.
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 Printer Menu

Item List

◎

◎ : Appears for a person logged in as a printer
administrator.

 View Information
Item

Item
Status

Description
Shows the current printer status. All warnings
and errors generated by the printer are shown
as "problem information". You can also check
the operational status of each network service,
a configuration list, and the IP address assigned
to the printer. For information about the status
window, see "To check using the "Status Screen""
(P.145).

Tray Count

Shows the print count.

Supplies Life

Shows the remaining life of consumables.

Usage Report

Shows usage reports.

Network

Can be used to check general information, TCP/
IP status, maintenance information, and other
network-related setup information.

System

Shows versions, memory capacity, flash memory
capacity, and system related information.

Description

General
Printer
Settings

Can be used to configure the printer name, asset
number, installation location, and other printer
settings.

Unwinder
Config

You can do settings related to the unwinder and
the paper loaded in the unwinder.

Cutter Setup

You can set the cutter operations and the cutting
interval. Appears when the unwinder is mounted.

System
Adjust

Can be used to configure the power save time, and
for clearing warnings, timeout printing, and other
printer operations.

Print Adjust

Can be used to configure print position adjustment,
print quality, and to adjust other settings.

Unit of
Measurement

You can set the units that are displayed.

 Admin Setup

◎

 Print Information ◎

Item

Item
Information
Print

Description
Can be used to configure print and check
information about the network, the font list, and
other printer settings.
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Description

Network
Setup

Can be used to configure TCP/IP and other protocol
settings.

Print Setup

Can be used to configure toner saving and other
printer settings.

PCL Setup

Can be used to configure PCL font and other PCL
settings.

Color Setup

Can be used to configure PostScript settings for
the CMYK data conversion process and other color
settings.

Management

Can be used to configure the power setup, job
cancel setup, and other printer settings.

Using a Web Browser to Configure the Network Setup

 Calibration

Changing an Administrator
Password

◎

You can use the procedure below to change
the password for logging in to the printer as an
administrator.
Item

Description

Normal
Setting

Adjusts the density of each color and other print
quality settings.

Customize
Menu

Used to perform density and registration
adjustment.

 Links

Item

Description

Links

Displays links configured by the administrator and
links configured by the manufacturer.

Edit Links

Allows administrator to set any URL. Up to five
support links and five other links can be registered.
Be sure to include http:// when entering the URL.

1
2

Click [Admin Setup] > [Management].
Click [Change Password] .
In [New Password], enter the new
password. In [Verify Password], enter
the new password again.

3
Note
 The password will appear on the screen as a series
of dots ( ●●●●● ) as you enter it.
 You can enter from 6 to 12 alphanumeric English
characters for a password.
 Note that passwords are case-sensitive, so enter
upper-case and lower-case letters correctly.

4
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Click [Submit].
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5

Checking Printer Settings
From a Computer

This saves the settings on the printer.
You do not need to re-start the printer. Use
the new password the next time you log in
as an administrator.

You can use the procedures below to check the
printer status from a computer over a network.

 To check using the "Status Screen"

1

Access the printer web page and open
the "Status" screen.

 To check using the "Status
Window"
Click [Status Window], which will display the
screen shown below.

Shows
printer
information.

Click
to update the
printer
status
with the
latest
information.

This
displays
details
about the
printer
status.

Printer Status Icon

Meaning
No error, online
Minor malfunction
(printing still possible)
Serious malfunction
(printing not possible)
Offline
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Changing Printer Settings
From a Computer
You can use the procedure below to change
printer settings.

1

Access the printer web page and log in
as an administrator.

Encrypting Communication
(SSL/TLS)
Communication between the computer (client)
and printer can be encrypted when configuring
settings, performing IPP printing, and when
receiving print data with FTP protocol.
(Encryption of SSL/TLS Communication)

 Configuring Settings
The procedure below shows how to use the web
to create a certificate with the printer.
The two types of certificates below can be
created.
 Self-signed certificate
 CA certificate (CSR creation)

2

After changing the settings you want,
click [Submit].

Memo
 If the printer's IP address is changed from what it was
when a certificate was created, that certificate become
invalid. Do not change the printer's IP address after
creating a certificate.

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

3

Click [SSL/TLS].
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4

Self-signed Certificate

Select the type of the certificate to
create in [Step 1].

To create a CA certificate, advance to "CA
Certificate" (P.148).



7

5

This displays the input.
Check the contents, and then click [OK].
This creates the certificate.

Enter information for the Common
Name, Organization, and other items.
Note
 If you selected "Use a certificate issued by a
certificate authority", perform detailed content
input and other certificate issuing procedures in
accordance with issuing authority procedures.

This completes self-signed certificate
creation.
Settings are saved on the printer and the
network function is restarted.

8

Perform steps 1 through 3 of this
procedure to display the encryption
(SSL/TLS) setup screen, and then
configure protocol settings to enable
encryption.

9

Click [Submit].

Memo
 If you selected a self-signed certificate, the printer's
IP address will be set for [Common Name].

If you want to change the key exchange
method and key size, click [Change these
settings]. (The initial default setting is
RSA, 1024 bits. Normally, you should use
this setting without modifying it.)

6

Click [OK].
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In this case, advance to "Usage Method"
(P.148).
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9

 CA Certificate

7

This displays the input.

This installs the certificate issued by
the CA (using the web). (For a CA
certificate)

Check the contents, and then click [OK].

Perform steps 1 through 3 of this procedure
to display the encryption (SSL/TLS) setup
screen.

8

Extract the CSR and send it to the
issuing authority. (For a CA certificate)

Paste the part of the generated certificate
from "----- BEGIN CERTIFICATE ----- " to "---- END CERTIFICATE ----- " into the text
box, and then click [Send].

Note
 Copy the contents of the text box from "----BEGIN CERTIFICATE REQUEST -----" to " ----- END
CERTIFICATE REQUEST ----- ". Depending on the
CA, sending the CSR may mean pasting it into web
page, sending it as a file, attaching it to a mail
message, etc.

This completes CA certificate creation.
Settings are saved on the printer and the
network function is restarted.

10

Perform steps 1 through 3 of this
procedure to display the encryption
(SSL/TLS) setup screen, and then
configure protocol settings to enable
encryption.

11

Click [Submit].

 Usage Method

1
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Start up the web browser, and then
enter "https://<printer IP address>" as
the address to connect.

Using a Web Browser to Configure the Network Setup

Printing with IPP

4

Select [Select a shared printer by
name].

5

Enter "http://<printer IP address>/ipp"
or "http://<printer IP address>/ipp/lp",
and then click [Next].

6

Click [Have Disk].

7
8

Insert the "Software DVD-ROM" into the
computer.

Printing can be performed using IPP.

 To enable IPP printing

1

Access the printer web page and log in
as an administrator.

2
3
4
5

Select [Admin Setup].
Select the following: [Network Setup] >
[IPP] > [Setting].
Follow the instructions that appear on
the display to configure the setup.
Click [Submit].

 To set up the printer as an IPP
printer (Windows)

1
2
3

Click [Start] and select [Control Panel]
in [Windows System].
Select [View devices and printers] >
[Add a printer].
From the list of usable printers, select
[The printer that I want isn’t listed].

For [Copy manufacturer's files from],
enter one of the paths below, and then
click [Find].
 PCL driver:
D:\Drivers\PCLXL

Memo
 The above is an example when the DVD-ROM drive
is the D: drive.

9
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Select the INF file, and then click
[Open].

Using a Web Browser to Configure the Network Setup

10
11

Encrypting Communication
(IPsec)

Click [OK].
Select the printer name, and then click
[Next].

You can configure the settings in this section
to encrypt and prevent tampering with
communication between the computer (client)
and printer at the network layer level.
Memo
 The IKE protocol supported by this printer is "IKEv1".
The communication mode supported by this printer is
"Transport Mode". It does not support "Tunnel Mode".
Printer response may slow down while IPsec is enabled,
depending on network communication conditions.

Note
 IPsec does not operate with the mail send function or
SNMP Trap function.

12
13
14

Click [Next].

 Setup Flow
Configure printer settings before configuring
computer settings.

Click [Finish].
A test page is printed after installation
is complete.

 To configure the printer setup
The procedure below shows how to use the web
to enable IPsec.

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

3

Click the [IPsec] tab.
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4

6

Under [STEP1], enable [IPsec].
Note

Using a Web Browser to Configure the Network Setup

Under [STEP3], configure the settings
of the Phase1 Proposal parameters.

(1)

For [IKE Encryption Algorithm],
select one of the following settings:
AES-CBC 256, AES-CBC 192, AESCBC 128, 3DES-CBC, DES-CBC.

(2)

For [IKE Hash Algorithm], select
SHA-1 or MD5.

(3)

For [Diffie-Hellman Group], select
Group2 or Group1.

(4)

For [Lifetime], enter and set a
value in the range of 600 (seconds)
to 86,400 (seconds).

 Set "Enable" for IPsec to encrypt communications
from the computer with the IP address you specified
in "STEP2".
 The web page will not open if IPsec setup fails
because the configured parameters to not match the
computer, or because of some other reason. If this
happens, use the control panel Network Setup item
to disable [IPsec], or perform network initialization
to disable IPsec.

5

Under [STEP2], enter the host IP
address.
Note
 Use an IP address to specify a host that is allowed
to print and configure settings.
 For the IPv4 address, use single-byte numerals
separated by periods (.).
 For the IPv6 address, use single-byte alphanumeric
characters separated by colons (:). Abbreviated
notation is not supported.

7

 Entry of IP address 0.0.0.0. is invalid.
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Under [STEP4], set the pre-shared key.
For [Pre-Shared Key], enter at least one and
no more than 64 single-byte alphanumeric
characters. Here, we will show an example
where "ipsec" is entered for the character
string.

Using a Web Browser to Configure the Network Setup

8

9

Under [STEP5], set the Key PFS.

Under [STEP6], configure Phase2
Proposal settings.
 To configure [ESP] settings

(1)

(2)

For [Key PFS], select KEYPFS or
NOPFS.

(1)

For [ESP Encryption Algorithm],
select one of the following settings:
AES-CBC 256, AES-CBC 192, AESCBC 128, 3DES-CBC, DES-CBC.

(2)

For [ESP Authentication Algorithm],
select SHA-1, MD5, or OFF. If you
select [OFF], the ESP verification
algorithm will not be applied.

If [Key PFS] is selected, select one
of the following settings for [Key
PFS Diffie-Hellman Group]: Group
2, Group 1, None.

 To configure [AH] settings

10
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(1)

For [AH Authentication Algorithm],
select SHA-1 or MD5.

(2)

For [LifeTime], enter and set a
value in the range of 600 (seconds)
to 86,400 (seconds).

Click [Submit].
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11

Settings are saved on the printer and
the network function is restarted.

 To configure computer settings

1
2

3

Click [Start], and then select [Control
panel] in [Windows System].
Click [System and Security].

Click [Administrative Tools].

 Connection Security Rules

4
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Double-click [Local Security Policy].
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5

Select [Windows Firewall with Advanced
Security] > [Windows Firewall with
Advanced Security - Local Group Policy
Object], right-click [Connection Security
Rules], and then select [New Rule].

8

9
6

Select [Advanced], and then click
[Customize].

Select [Custom], and then click [Next].

10
7

Select [Require authentication for
inbound connections and request
authentication for outbound
connections], and then click [Next].

Select Endpoint 1 and 2. Configure as
required, and then click [Next].

11
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In the [First authentication] section,
click [Add].

Select [Preshared Key] and enter the
key, and then click [OK].
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12

Click [OK].

13
14

Click [Next].

15

16

 IPsec Setup

17

Open the [Local Security Policy] of the
[Administrative Tools].

18

Right-click [Windows Firewall with
Advanced Security], and then select
[Properties].

19

Select the [IPsec Settings] tab. Next,
in the [IPsec defaults] section, click
[Customize].

Click [Next].

After confirming that all of the check
boxes are selected, click [Next].

Enter a name, and then click [Finish].
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20

In the [Key exchange (Main Mode)]
section, select [Advanced], and then
click [Customize].

23

Configure the settings you want, and
then click [OK].

Note
 Support is provided only for time indicated by the
key lifetime. To disable session-specific (IPsec
communication data size) conditions, set the
maximum value.
 Select "ESP+AH" as the protocol.

21

Change the [Security Methods] as
required, and then click [OK].

22

In the [Data protection (Quick Mode)]
section, select [Advanced], and then
click [Customize].

24

In the [Authentication method] section,
select [Advanced], and then click
[Customize].

25

In the [First authentication] section,
click [Add].
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26

Controlling Access by IP
Address (IP Filter)

Select [Preshared Key] and enter the
key, and then click [OK].

Access to the printer can be managed using IP
addresses.
Note
 [IP Filtering] is set to [Disable] under the printer initial
default settings.
 Take care to enter the IP address correctly. An incorrectly
entered IP address can make it impossible to access the
printer using IP protocol.

1
27

28

29

Click [OK].

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

3

Click [IP Filtering].

Click [OK] to exit [Customize IPsec
Settings].

Click [OK].
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4

Under [STEP1], select [Enable] for [IP
Filtering].

7

Even if the wrong settings are configured
in [STEP2] due to administrator IP address
entry in [Administrator’s IP Address
setting], the administrator can re-configure
the setting from a host with the IP address
specified with [Administrator’s IP Address
setting].

Note
 Enabling IP filtering disables all access from hosts
that are outside the range of IP addresses specified
in [STEP2].

5

Under [STEP2], specify the IP address
range.

Note

Note

 If the printer is being accessed via a proxy, the
intermediate device's address will be displayed
as [Your Current Local Host/Proxy IP Address].
Consequently, the address shown by [Your Host IP
Address] may be different from your actual host
address.

 Using IP addresses, enter the range of hosts that
are allowed to print and configure settings.
 For the IP addresses, use single-byte numerals
separated by periods (.).

 If nothing is registered for the administrator IP
address, the setting in [STEP2] may make the
printer completely inaccessible.

 Entry of IP address 0.0.0.0. is invalid.
 When there is overlap of IP addresses, the address
range with the highest level set in [Priority] is given
priority.
 Regardless of what is specified in [STEP2], you can
use [STEP3] to specify administrator addresses
for which printing and setting configuration are
enabled.

6

Under [STEP3], specify the
[Administrator’s IP Address setting].

Click [Address Range Bar Display/
Refresh].

If you want to modify an IP address range,
re-enter the applicable IP addresses, and
click [Address Range Bar Display/Refresh].

 If you do not want to register an administrator IP
address, leave [Administrator’s IP Address setting]
blank.

8

Click [Submit].

9

Settings are saved on the printer and
the network function is restarted.
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Controlling Access by MAC
Address

4

Under [STEP1], select [Enable] for [MAC
Address Filtering].

5

Under [STEP2], You can select [Accept]
or [Deny] for communication from
specific MAC addresses.

Access to the printer can be managed using MAC
addresses.

Note
 Incorrectly entering a MAC address can make it impossible
to access the printer using a network. Exercise caution
when entering an address.

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

3

Click [MAC Address Filtering].

Note
 Using MAC addresses, enter the range of hosts
whose communications are allowed or rejected.
 For the MAC addresses, use single-byte numerals
separated by periods (:).
 Regardless of what is specified in [STEP2], you can
use [STEP3] to specify administrator addresses for
which communication is enabled.
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6

Sending Error Notifications
by Mail

Under [STEP3], specify the
[Administrator’s MAC Address setting].

The printer comes with a mail sending function
(SMTP) built-in. It can be configured to send a
mail message whenever an error occurs. You can
select whether to send a periodic mail message
about errors, or to send a mail message as soon
as an error occurs.

 To configure settings for sending
mail

Even if the wrong settings are configured in
[STEP2] due to administrator MAC address
entry in [Administrator’s MAC Address
setting], the administrator can re-configure
the setting from a host with the MAC
address specified with [Administrator’s MAC
Address setting].

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click: [Admin Setup] > [Network
Setup].

3

Click: [Email] > [Send Settings].

Note
 If the printer is being accessed via a proxy, the
intermediate device's address will be displayed
as [Your Host MAC Address]. Consequently, the
address shown by [Your Host MAC Address] may be
different from your actual host address.
 If nothing is registered for the administrator MAC
address, the setting in [STEP2] may make the
printer completely inaccessible.
 If you do not want to register an administrator
MAC address, specify 00:00:00:00:00:00 for
[Administrator’s MAC Address setting].

7

Click [Submit].

8

Settings are saved on the printer and
the network function is restarted.
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4

Under [STEP1], select [Enable] for
[SMTP Send].

5

Under [STEP2], specify the required
addresses.

6

To configure more advanced settings
from this point, click [Set detail of the
SMTP Protocol.] for [STEP3].

Otherwise, jump to step 16 of this
procedure.

(1)

For [SMTP Server], specify the mail
server domain name or IP address.

(2)

For [Printer Email Address], specify
the mail address assigned to the
printer.

7

Click [Security Settings].

8

For [SMTP Port Number], specify the
mail server port number.

9

Select [Enable] for [SMTP-Auth].

Note
 To configure SMTP server settings with a domain
name, you need to configure DNS server settings
with the [TCP/IP] setup.
 The mail server needs to be configured to allow
the printer to send mail. For information about
mail server settings, consult with your network
administrator.
 Internet Explorer 7 configured with its initial default
setup will not perform a send test.
To perform a send test, you need to change the
setup of Internet Explorer 7.
Select [Tools] > [Security Level Customization],
and then enable [Allow websites to prompt for
information using scripted windows].

10
11
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(1)

For [User ID], specify the user ID
for connection to the mail server.

(2)

For [Password], specify the
password for connection to the
mail server.

Click [OK].
Click [Configure attached information].
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12

Select or enter the information you
want to add to the end of the message
text.

13
14
15

Click [OK].

16
17
18

Sending Error Notifications
by Periodic Mail
 To send periodic notifications
about problems
For periodic notification, check that Auto Power
Off setting is either Auto Config or Disable.

Click [Others].
For [Reply-To Address], specify the
return address for the mail sent from
the printer. Normally, specify the mail
address of the printer administrator.

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

Click: [Admin Setup] > [Network
Setup].

3

Click: [Email] > [Alert Settings].

Click [OK].
Click [Submit].
Settings are saved on the printer and
the network function is restarted.

Memo
 The authentication method is automatically selected from
among authentication methods supported by the mail
server.
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4

Enter the mail address of the
malfunction notification recipient.

5

Click [Setting] of the mail address you
want to specify.

8

Under [Setting Events Used for Sending
Email Alerts], select the check boxes of
the error types for you to be notified of.

Memo
 Malfunction notification condition settings can be
copied to another addressee by clicking [Copy]. This
is useful when sending malfunction notifications to
multiple recipients with similar mail addresses.

6

Select the [Periodically] check box, and
then click [To STEP2].

9
10

Click [OK].
Check the configuration of the
malfunction notification conditions.
 To display as a list

(1)
(2)

7

For [Email Alert Interval], specify the
mail send interval.

Memo
 Mail is not sent if there are no reportable errors
within the period.
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Click [Show current settings table].
Check the configuration, and then
close the window.
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 To compare the setting conditions of two
recipients

 To send alerts when problems
occur

(1)

Use the list box to select each
of the recipients you want to
compare.

1

Click: [Email] > [Alert Settings].

(2)

Check the displayed configuration.

2

Enter the mail address of the
malfunction notification recipient.

3

Click [Setting] of the mail address you
want to specify.

Memo
 You can change notification condition settings by
clicking inside the setting condition comparison
table. 

11

Click [Submit].

Memo

12

Settings are saved on the printer and
the network function is restarted.

 Malfunction notification condition settings can be
copied to another addressee by clicking [Copy]. This
is useful when sending malfunction notifications to
multiple recipients with similar mail addresses.

4
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Select the [Upon occurrence of an
event] check box, and then click [To
STEP2].
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5

Under [Setting Events Used for Sending
Email Alerts], select the check boxes of
the error types for you to be notified of.

8

Check the configuration of the
malfunction notification conditions.
 To display as a list

(1)
(2)

6

Click [Show current settings table].
Check the configuration, and then
close the window.

 To compare the setting conditions of two
recipients

Specify the delay after an error occurs
until the message is sent, and then click
[OK].

(1)

Use the list box to select each
of the recipients you want to
compare.

(2)

Check the displayed configuration.
Memo

 You can change notification condition settings by
clicking inside the setting condition comparison
table.

Memo
 Setting a delay time makes it possible to send
notifications only of errors that are generated only
over a long period of time.
 Setting "0 hours, 0 minutes" for the delay time,
causes the message to be sent immediately after an
error occurs.

7

Click [OK].

9

Click [Submit].

10

Settings are saved on the printer and
the network function is restarted.
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Using SNMPv3
This printer implements an SNMPv3 compatible
agent.

4

Select the check box of the SNMP
version to be used in [STEP1], and then
click [To STEP2].

You can use an SNMPv3 compatible SNMP
manager to encrypt printer administration with
SNMP for greater security.

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

On the [Admin Setup] tab, click
[Network Setup].

Memo
 If [SNMPv3] is selected, you will not be able to view
or configure settings with SNMPv1. If [SNMPv3+v1]
is selected, you will be able to view settings with
either SNMPv1 or SNMPv3, but you can configure
settings using SNMPv3 only.

3

5

In [STEP2], enter an SNMPv3 user
name for [User Name].

6

Enter the passphrase for verification
in [Passphrase] for [Authentication
Settings].

Click [SNMP] > [Settings].
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7

Using IEEE802.1X

Select [Algorithm].

Authentication is in accordance with IEEE802.1X.

 IEEE802.1X Setup Flow
To configure IEEE802.1X settings on the printer,
first connect the printer and computer via a
normal hub for setup. After completing the
IEEE802.1X setting configuration procedure,
connect the printer to the authentication switch.

8

Enter the passphrase for encryption in
[Passphrase] for [Privacy (Encription)
Settings].

1
2
3
4
5

Memo
 You can select [DES] only for the encryption
algorithm.

9

Click [Submit].

10

Settings are saved on the printer and
the network function is restarted.
Memo

 For the context key of the SNMP manager to be used,
specify "v3context".
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Connect the printer to a computer.
On the computer, specify an IP address for
setting up.
On the printer, specify an IP address for
setting up.
On the printer, configure IEEE802.1
settings.
Connect the printer to the
authentication switch.

Using a Web Browser to Configure the Network Setup

To use PEAP

 To configure IEEE802.1 settings

1

Log in as an administrator.
Reference
 See "Logging in as an Administrator" (P.142).

2

4
5

For the [IEEE802.1X] setting, select
[Enable].

6
7

In [EAP User], enter the user name.

For [EAP Type], select [PEAP].

On the [Admin Setup] tab, click
[Network Setup].



3

Click [IEEE802.1X].

8

Reference
 If PEAP is to be used, proceed to " To use PEAP".
If EAP-TLS is to be used, proceed to " To use EAPTLS".
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In [EAP Password], enter the password.

Select the [Authenticate Server] check
box.
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To use EAP-TLS

9

Click [Import of CA Certificate].
Memo
 If the [Not authenticate Server] check box is
selected, import of a CA certificate is not required.
If the [Not authenticate Server] check box is
selected, there is no confirmation to determine if
the connection is to a properly authenticated server.

4
5

For the [IEEE802.1X] setting, select
[Enable].

6
7
8

In [EAP User], enter the user name.

For [EAP Type], select [EAP-TLS].



This displays the "Import of CA Certificate"
screen.

10

Enter the file name of the CA certificate,
and then click [OK].
Memo

Select the [Not use SSL/TLS Certificate
for EAP authentication] check box.
Click [Import of Client Certificate].

 The imported CA certificate is a certificate of the
server certificate issuing authority of the RADIUS
server.
 Supported import file formats are PEM, DER, and
PKCS#7.

This displays the "Import of Client
Certificate" screen.
The CA certificate is imported by the printer.

11
12

9

Click [Submit].
Settings are saved on the printer and
the network function is restarted.
When the standby screen appears on the
control panel, turn off the printer.

Enter the file name of the client
certificate.

Memo
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The importable certificate file format is PKCS#12.
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10

Enter the client certificate password,
and then click [OK].

13

Enter the file name of the CA certificate,
and then click [OK].

Memo
 The imported CA certificate is a certificate of the
server certificate issuing authority of the RADIUS
server.
 Supported import file formats are PEM, DER, and
PKCS#7.

The client certificate is imported by the
printer.

11

Select the [Authenticate Server] check
box.

12

Click [Import of CA Certificate].

The CA certificate is imported by the printer.

14

Memo
 If the [Not authenticate Server] check box is
selected, import of a CA certificate is not required.
If the [Not authenticate Server] check box is
selected, there is no confirmation to determine
if the connection is to the correct authenticated
server.

15
This displays the "Import of CA Certificate"
screen.

Click [Submit].

Settings are saved on the printer and
the network function is restarted.
When the standby screen appears on the
control panel, turn off the printer.
Reference
 For information about how to turn off the printer,
refer to the "Setup Guide".
 Advance to "To connect the printer to an
authentication switch" (P.171).
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 To connect the printer to an
authentication switch
Memo
 Confirm that the printer is turned off.

1
2

Plug a LAN cable into the printer's LAN
(network) interface connector.

3
4
5

Turn on the power supply of the printer.

Plug the LAN cable into the
authentication switch's authentication
port.

Confirm that the standby screen is
displayed on the control panel.
Configure settings in accordance with
the operating environment, such as the
printer's IP address, etc.
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Network Extension

Network Extension
Network Extension makes it easy to check printer setup items from a printer driver.
Reference
 Network Extension is installed along with the printer drivers.

Operating Environment

Checking the Printer
Settings

Computer running Windows 10/Windows
8.1/Windows 8/Windows 7/Windows Server
2016/Windows Server 2012 R2/Windows
2012/Windows Server 2008 R2/ Windows
Server 2008

You can use the procedure below to check
connected printer configuration, etc.
Note

Computer running TCP/IP

 Even if Network Extension is installed, the [Options]
tab will not be displayed if the operating environment is
incompatible.

Note
 To link operation with a printer driver, you need to install
the printer driver.
 Network Extension is installed automatically when a
printer driver is installed on a TCP/IP network connection.
 Operation is supported only for the printer driver
connection destinations shown below.

1
2

Click [Start] and select [Control Panel]
in [Windows System].

3
4

Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].

Click [View devices and printers].

- Afinia Label LPR Port
- Standard TCP/IP port
 PC administrator privileges are required for the setup.
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Click the [Status] tab.

Network Extension

5

Uninstalling Network
Extension

Click [Update].

The printer configuration is displayed under
"Device Setting".

6

1
2
3

Click [Start], and then select [Control
panel] in [Windows System].

4

Follow the instructions on the screen to
uninstall.

Click [OK].
Memo

 Clicking [Web Setting] automatically starts up the web
browser, which will display the printer configuration.
For details, see "Using a Web Browser to Configure the
Network Setup" (P.141).
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Click [Uninstall a program].

Select [Afinia Label Network
Extension], and then click
[Uninstall].
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